User’s Manual

Model  GX10/GX20/GP10/GP20

Paperless Recorder
First Step Guide

Contents

Introduction ................................................................. 1
Handling Precautions of the GX/GP ................................. 2
SD Memory Card Handling Precautions ............................ 6
Checking the Package Contents ............................... 6
Standard Accessories .................................................. 9
Conventions Used in This Manual ............................... 10
Protection of Environment ....................................... 11

Functional Overview ...................................................... 12
Overview ...................................................................... 12
A Variety of Source Signals ............................................. 12
Expandable Module Construction ...................................... 12
GX60 Connection and Multichannel Measurement .......... 13
High-speed Measurement, Dual Interval Measurement (Measurement mode) .............................................. 13
Loop Control and Program Control Function (PG Option) .................................................................. 13
Data Storage .................................................................. 13
A Variety of Display Functions .......................................... 13
Touch Screen .................................................................. 14
Freehand Messages ....................................................... 14
Versatile Network Functions and Software ....................... 14
Other Functions .......................................................... 15
System Configuration .................................................. 16

Component Names ......................................................... 17
GX20/GX10 .................................................................. 17
GP20/GP10 ................................................................. 18
GX60/GX90EX .............................................................. 18
GX90XA/GX90XD/GX90YD/GX90WD/GX90XP/GX90YA/GX90UT .................................................. 19

Operating Procedure ...................................................... 22
Installation and Wiring .................................................. 24
Installation Location .................................................... 24
Installation Procedure ................................................. 25
External Dimensions and Panel Cut Dimensions ............... 25
Connect an GX60 .......................................................... 28
Installing and Removing I/O Modules ........................... 29
Wiring ......................................................................... 30

Basic Operation ............................................................. 39
Turning the Power On and Off ........................................ 39
Setting and Removing SD Memory Cards ....................... 40
Viewing the Operation Screen ....................................... 40
Displaying the Menu Screen .......................................... 41
Setting the Date and Time* .......................................... 41
Configuring the Inputs ................................................ 42
Starting Measurement and Recording ......................... 42
Switching between Operation Screens ......................... 42
Saving Data to USB Memory ......................................... 43
Switching the Quick Settings (GP only) ......................... 43

Advanced Operation (Various settings and operation) 44
Setting Measurement and Recording Conditions ........... 44
Setting Alarms ............................................................ 44
Alarm DO output ........................................................ 45
Using the Scaling Function (Measuring a flow meter) .... 45
Using the Scaling Function (Measuring a temperature) ... 46
Registering and Deleting Favorite Screens ................... 46

Setting the Measurement Mode ....................................... 47
Setting the Measurement Mode ..................................... 47
Limitations ................................................................ 47

Reconfiguring the GX/GP (Module identification) 48
Reconfiguring the GX/GP ............................................... 48
Initializing the GX/GP (Initializing all settings) ............... 48

Saving and Loading Setting Parameters ........................ 49
Saving Setting Parameters ........................................... 49
Loading Setup Parameters ........................................... 49

Web Application .......................................................... 50
Starting the Web Application ....................................... 50
Closing the Web Application ....................................... 50

Application Software ..................................................... 51
PC System Requirements ............................................ 51
Installation ................................................................. 51
Starting and Closing Universal Viewer ......................... 52
Starting and Closing Hardware Configurator ............... 52

Setup Menu Map .......................................................... 53

IM 04L51B01-02EN
11th Edition
User Registration

Thank you for purchasing YOKOGAWA products.

We invite you to register your products in order to receive the most up to date product information. To register, visit the following URL.

http://www.yokogawa.com/ns/reg/
Introduction
Thank you for purchasing the SMARTDAC+ GX/GP Series Paperless Recorder (hereafter referred to as the GX/GP). This manual explains the basic operation, installation, and wiring of the GX/GP.

For details on configuring and operating the GX/GP, see the “Paperless Recorder User’s Manual (IM 04LS1B01-01EN)” provided in electronic format.

For details on the settings and operation of the PID control module and program control (/PG option), see the Loop Control Function, Program Control Function (/PG Option) User’s Manual (IM 04LS1B01-31EN), provided as an electronic manual.

This manual supports the following products.

<table>
<thead>
<tr>
<th>Model</th>
<th>Product Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX10/GX20</td>
<td>Paperless Recorder (panel mount type)</td>
</tr>
<tr>
<td>GP10/GP20</td>
<td>Paperless Recorder (portable type)</td>
</tr>
<tr>
<td>GX60</td>
<td>I/O Base Unit (Expandable I/O)</td>
</tr>
</tbody>
</table>

Although the display of GX20 is used in this guide, GX10/GP10/GP20 can be operated similarly.

For a detailed description of the product, see the electronic manual.

For specifications, refer to General Specifications.

Electronic Manuals
You can download these manuals from the following web page:


<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Models GX10/GX20/GP10/GP20 Paperless Recorder First Step Guide</td>
<td>IM 04LS1B01-02EN</td>
</tr>
<tr>
<td>Precaution on the use of SMARTDAC+</td>
<td>IM 04LS1B01-01EN</td>
</tr>
<tr>
<td>Only delivered with each module or GX60</td>
<td></td>
</tr>
</tbody>
</table>

QR Code
The product has a QR Code pasted for efficient plant maintenance work and asset information management. It enables confirming the specifications of purchased products and user’s manuals. For more details, please refer to the following URL.

https://www.yokogawa.com/qrcode

QR Code is a registered trademark of DENSO WAVE INCORPORATED.

Notes
- The contents of this manual are subject to change without prior notice as a result of continuing improvements to the instrument’s performance and functions.
- Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact your nearest Yokogawa dealer.
- Copying or reproducing all or any part of the contents of this manual without the permission of Yokogawa is strictly prohibited.

Authorised Representative for the EEA
The Authorised Representative for this product in the EEA is: Yokogawa Europe B.V.
Euroweg 2, 3825 HD Amersfoort, The Netherlands

Revisions
- December 2012: 1st Edition
- February 2013: 2nd Edition
- May 2013: 3rd Edition
- May 2014: 4th Edition
- December 2014: 5th Edition
- June 2017: 7th Edition
- November 2017: 8th Edition
- June 2018: 9th Edition
- July 2018: 10th Edition
- March 2019: 11th Edition
Trademarks

- SMARTDAC+ and SMARTDACPLUS are registered trademark of Yokogawa Electric Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Pentium is a trademark of Intel Corporation in the United States and/or other countries.
- Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems Incorporated.
- Kerberos is a trademark of Massachusetts Institute of Technology (MIT).
- The SD logo is a registered trademark of the SD association.
- Company and product names that appear in this manual are registered trademarks or trademarks of their respective holders.
- The company and product names used in this manual are not accompanied by the registered trademark or trademark symbols (® and ™).
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Precautions, Installation and Wiring, Basic operation of the GX/GP</td>
<td>First Step Guide IM 04L51B01-02EN</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
<tr>
<td>basic operation and setting of the GX/GP.</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Math function (/MT)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Report function (/MT)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Report Template Function (/MT)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Batch Function</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Modbus Function</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>DARWIN compatible communication function</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Communication channel function (/MC)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Serial communication function (/C2, /C3)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>WT Communication (/E2)</td>
<td>WT Communication (/E2) User’s Manual IM 04L51B01-19EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Aerospace heat treatment (/AH)</td>
<td>User’s Manual IM 04L51B01-01EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Multi Batch Function (/BT)</td>
<td>Multi Batch Function (/BT) User’s Manual IM 04L51B01-03EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>OPC-UA Server (/E3)</td>
<td>OPC-UA Server (/E3) User’s Manual IM 04L51B01-20EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>SLMP Communication (/E4)</td>
<td>SLMP Communication (/E4) User’s Manual IM 04L51B01-21EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Custom Display (/CG option)</td>
<td>DXA170 DAQStudio IM 04L41B01-62EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Log Scale (/LG)</td>
<td>Log Scale (/LG) User’s Manual IM 04L51B01-06EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Loop Control Function, Program Control Function (/PG)</td>
<td>Loop Control Function, Program Control Function (/PG Option) User’s Manual IM 04L51B01-31EN</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>
Safety Precautions

- This instrument conforms to IEC safety class I (provided with terminal for protective grounding), Overvoltage Category II or I, and EN61326-1 (EMC standard), Measurement Category II (CAT II).*
- Measurement Category II (CAT II) are for the analog input modules (GX90XA) and PID control module (GX90UT).
Measurement category II (CAT II) applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power from fixed equipment such as electric switchboards.
- This instrument is an EN61326-1 (EMC standard) class A instrument (for use in commercial, industrial, or business environments). The influence rate (judgment condition A) in the immunity test environment is within ±10 % of the range.
- The general safety precautions described here must be observed during all phases of operation. If the SMARTDAC+ is used in a manner not described in this manual, the SMARTDAC+ safety features may be impaired. Yokogawa Electric Corporation assumes no liability for the customer’s failure to comply with these requirements.
- The SMARTDAC+ is designed for indoor use.

About This Manual

- Please pass this manual to the end user. We also ask you to store this manual in a safe place.
- This guide is intended for the following personnel: Engineers responsible for installation, wiring, and maintenance of the equipment. Personnel responsible for normal daily operation of the equipment.
- Read this manual thoroughly and have a clear understanding of the product before operation.
- This manual explains the functions of the product. It does not guarantee that the product will suit a particular purpose of the user.

Precautions Related to the Protection, Safety, and Alteration of the Product

The following safety symbols are used on the product and in this manual.

- **Handle with care.** To avoid injury and damage to the instrument, the operator must refer to the explanation in the manual.
- **Protective ground terminal**
- **Functional ground terminal** (do not use this terminal as a protective ground terminal.)
- **Alternating current**
- **Direct current**
  - ON (power)
  - OFF (power)
- For the protection and safe use of the product and the system in which this product is incorporated, be sure to follow the instructions and precautions on safety that are stated in this manual whenever you handle the product.

Take special note that if you handle the product in a manner that violates these instructions, the protection functionality of the product may be damaged or impaired. In such cases, Yokogawa does not guarantee the quality, performance, function, and safety of the product.

- When installing protection and/or safety circuits such as lightning protection devices and equipment for the product and control system or designing or installing separate protection and/or safety circuits for fool-proof design and fail-safe design of the processes and lines that use the product and the control system, the user should implement these using additional devices and equipment.
- If you are replacing parts or consumable items of the product, make sure to use parts specified by Yokogawa.
- This product is not designed or manufactured to be used in critical applications that directly affect or threaten human lives. Such applications include nuclear power equipment, devices using radioactivity, railway facilities, aviation equipment, air navigation facilities, aviation facilities, and medical equipment. If so used, it is the user’s responsibility to include in the system additional equipment and devices that ensure personnel safety.
- Do not modify this product.

- **Use the Correct Power Supply**
  Ensure that the source voltage matches the voltage of the power supply before turning ON the power. In the case of portable type and the GX60 (power inlet type), ensure that it is within the maximum rated voltage range of the provided power cord before connecting the power cord.
- **Use the Correct Power Cord and Plug** (Portable Type, GX60 (power inlet type))
  To prevent electric shock or fire, be sure to use the power cord supplied by Yokogawa. The main power plug must be plugged into an outlet with a protective earth terminal. Do not disable this protection by using an extension cord without protective earth grounding.
  The power cord is designed for use with this instrument. Do not use the power cord with other instruments.
- **Connect the Protective Grounding Terminal**
  Make sure to connect the protective grounding to prevent electric shock before turning ON the power.
  The power cord that comes with the portable type and the GX60 (power inlet type) are three prong type power cord. Connect the power cord to a properly grounded three-prong outlet.
- **Do Not Impair the Protective Grounding**
  Never cut off the internal or external protective grounding wire or dis-
connect the wiring of the protective grounding terminal. Doing so invalidates the protective functions of the instrument and poses a potential shock hazard.

- **Do Not Operate with Defective Protective Grounding**
  Do not operate the instrument if the protective grounding might be defective. Also, make sure to check them before operation.

- **Do Not Operate in an Explosive Atmosphere**
  Do not operate the instrument in the presence of flammable gas, vapors, or combustible dust. Operation in such an environment constitutes a safety hazard. Prolonged use in a highly dense corrosive gas (H₂S, SOₓ, etc.) will cause a malfunction.

- **Do Not Remove Covers**
  The cover should be removed by Yokogawa’s qualified personnel only. Opening the cover is dangerous, because some areas inside the instrument have high voltages.

- **Ground the Instrument before Making External Connections**
  Connect the protective grounding before connecting to the item under measurement or control unit.

- **Damage to the Protection**
  Operating the instrument in a manner not described in this manual may damage the instrument’s protection.

- **Wiring**
  To prevent shock, attach the included terminal cover after wiring. Make sure to use appropriate wires and crimp-on lugs.
  If hazardous external voltage (30 V AC or 60 V DC or more) is applied to the I/O terminals, provide adequate protection to prevent users or service engineers from suddenly touching the terminals or tools or the like from coming in contact with the terminals.

---

**Exemption from Responsibility**
- Yokogawa makes no warranties regarding the product except those stated in the WARRANTY that is provided separately.
- Yokogawa assumes no liability to any party for any loss or damage, direct or indirect, caused by the user or any unpredictable defect of the product.

**Software Handling Precautions**
- Yokogawa makes no warranties, either expressed or implied, with respect to the software’s merchantability or suitability for any particular purpose, except as specified in the terms of the separately provided warranty.
- All reverse-engineering operations, such as reverse compilation or the reverse assembly of the product are strictly prohibited.
- No part of the product’s software may be transferred, converted, or sublet for use by any third party, without prior written consent from Yokogawa.

About the Usage of Open Source Software
关于开放源代码软件的使用
This product uses open source software.
For details on using open source software, see Regarding the Downloading and Installing for the Software, Manuals and Labels (IM 04L61B01-11EN).
Handling Precautions of the GX/GP

- Use care when cleaning this instrument, especially its plastic parts. Use a soft dry cloth. Do not use organic solvents, such as benzene or thinner, or other cleansers. They may cause discoloring and deformation.
- Keep electrically charged objects away from the signal terminals. Failure to do so may damage the GX/GP.
- Do not apply volatile chemicals to the display, panel keys, etc. Do not allow rubber and vinyl products to remain in contact with the GX/GP for long periods of time. Doing so may damage the GX/GP.
- When not in use, make sure to turn off the power switch.
- If there are any symptoms of trouble such as strange odors or smoke coming from the GX/GP, immediately turn off the power switch and the power supply source. Then, contact your nearest Yokogawa dealer.

SD Memory Card Handling Precautions

- SD memory cards are delicate and should be handled with caution.
- Yokogawa provides no warranty for damage to, or loss of data recorded on the SD memory card, regardless of the cause of such damage or loss. Please always make backup copies of your data.
- Do not store or use the SD memory card in places with static electricity, near electrically charged objects, or where electrical noise is present. Doing so can result in electric shock or damage.
- Do not disassemble or modify the SD memory card. Doing so can result in damage.
- Do not physically shock, bend, or pinch the SD memory card. Doing so can lead to malfunction.
- During reading/writing of data, do not turn OFF the power, apply vibration or shock, or pull out the card. Data can become corrupt or permanently lost.
- Only use Yokogawa SD memory cards. Operation cannot be guaranteed with other brands of card.
- When inserting the SD memory card into the instrument, make sure you orient the card correctly (face up or down) and that you insert it securely. If not inserted correctly, the card will not be recognized by the instrument.
- Never touch the SD memory card with wet hands. Doing so can lead to electric shock or malfunction.
- Never use the SD memory card if it is dusty or dirty. Doing so can lead to electric shock or malfunction.
- The SD memory card comes formatted. SD cards must be formatted according to the standard established by the SD Association (https://www.sdcard.org/home). If you want format the SD memory card, use the instrument’s Format function. If using a PC to perform the formatting, use the SD card formatter software available from the above SD Association.
- You can use SD/SDHC cards (up to 32 GB) on the GX/GP.

SD Memory Card Specifications and Characteristics

<table>
<thead>
<tr>
<th>Electrical specifications</th>
<th>Operating voltage: 2.7 V to 3.6 V (memory operation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature / humidity conditions</td>
<td>−25 to 85°C / 20 to 85% RH, no condensation</td>
</tr>
<tr>
<td>Storage temperature / humidity conditions</td>
<td>−40 to 85°C / 5 to 95% RH, no condensation</td>
</tr>
</tbody>
</table>

Unit: mm

32 ± 0.1

Checking the Package Contents

After receiving the product and opening the package, check the items described below. If the wrong items have been delivered, if items are missing, or if there is a problem with the appearance of the items, contact your nearest Yokogawa dealer.

Check that the product that you received is what you ordered by referring to the model name and suffix code given on the name plate on the GX/GP.

NO. (Instrument Number)

When contacting the dealer from which you purchased the instrument, please give them the instrument number.
### Model and Suffix Codes

#### GX10/GX20

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Optional Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX10</td>
<td>Paperless recorder (Panel mount type, Small display)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GX20</td>
<td>Paperless recorder (Panel mount type, Large display)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Optional Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>Standard (max. no. of measurement ch : 100)</td>
<td></td>
</tr>
<tr>
<td>-2</td>
<td>Large Memory (max. no. of measurement ch : 500)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Language</th>
<th>Optional Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>English, degF, DST (summer/winter time)</td>
<td></td>
</tr>
</tbody>
</table>

#### Options

- [AH] Aerospace heat treatment
- [AS] Advanced security function
- [BC] Black cover
- [BT] Multi-batch function
- [C2] RS-232
- [C3] RS-422/485
- [CG] Custom display function
- [D5] VGA output
- [E1] EtherNet/IP communication (PLC communication protocol)
- [E2] WT communication
- [E3] OPC-UA server
- [E4] SLMP communication (Mitsubishi PLC)
- [FL] Fall output, 1 point
- [LG] LOG scale
- [MT] Mathematical function (with report function)
- [IP1] 24 VDC/AC power supply
- [IPG] Program control function
- [UH] USB Interface (host 2 ports)
- [UC10] With analog input module, 10ch (Clamp terminal)
- [UC20] With analog input module, 20ch (Clamp terminal)
- [UC30] With analog input module, 30ch (Clamp terminal)
- [UC40] With analog input module, 40ch (Clamp terminal)
- [UC50] With analog input module, 50ch (Clamp terminal)
- [US10] With 10ch analog input module (M3 screw terminal)
- [US20] With 20ch analog input module (M3 screw terminal)
- [US30] With 30ch analog input module (M3 screw terminal)
- [US40] With 40ch analog input module (M3 screw terminal)
- [US50] With 50ch analog input module (M3 screw terminal)
- [CR10] Digital output module, digital input module

#### Models in Which I/O Modules Are Preinstalled

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Optional Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX10</td>
<td>-E- [] []</td>
<td>Paperless recorder (panel mount type)</td>
<td></td>
</tr>
<tr>
<td>GX20</td>
<td>-E1 [] []</td>
<td>Paperless recorder (portable type)</td>
<td></td>
</tr>
</tbody>
</table>

#### Options (analogue input)

- [UC10] With analog input module, 10ch (Clamp terminal)
- [UC20] With analog input module, 20ch (Clamp terminal)
- [UC30] With analog input module, 30ch (Clamp terminal)
- [UC40] With analog input module, 40ch (Clamp terminal)
- [UC50] With analog input module, 50ch (Clamp terminal)
- [US10] With 10ch analog input module (M3 screw terminal)
- [US20] With 20ch analog input module (M3 screw terminal)
- [US30] With 30ch analog input module (M3 screw terminal)
- [US40] With 40ch analog input module (M3 screw terminal)
- [US50] With 50ch analog input module (M3 screw terminal)

#### Options (digital I/O)

- [CR10] With digital I/O module (output: 0, input: 16)
- [CR10] With digital I/O module (output: 24, input: 0)
- [CR20] With digital I/O module (output: 12, input: 0)
- [CR40] With digital I/O module (output: 24, input: 0)
1 /C2 and /C3 cannot be specified together.
2 /D5 can be specified only for the GX20/GP20.
3 Only one option can be specified.
4 Only one option can be specified.
7 If /UC30 or /US30 is specified for the GX10/GP10, /CR01, /CR10, and /CR11 cannot be specified.
8 A digital input module has M3 screw terminals.
9 The Display language is selectable from English, German, French, Russian, Korean, Chinese, Japanese.
To confirm the current available languages, please visit the following website.
URL: www.yokogawa.com/ns/language/
10 Solid state relay type (Type Suffix Code: -U2).
11 Optional code MT (MATH) required if using the pulse input.
12 To connect an I/O base unit, you will need one I/O expansion module for the GX/GP.
13 All devices require a communication channel (/MC) for input or output.
14 /MT option must be separately specified when the WT communication is selected.
15 This is applicable only when a GX90UT PID Control Module is installed.
16 This is applicable only when the power cord suffix code is D or F or Q or H or N.
17 Selectable only for the GP10 when the power cord suffix code is W.
18 The /MT option (computation) is required to perform pulse integration on GX90XP pulse input modules.
19 If you want to write from a PLC to the GX/GP via EtherNet/IP communication, a separate communication channel (MC) is required.
20 If you want to load data from other devices into the GX/GP using Modbus client, a communication channel (MC) is required.
21 This is applicable only when a GX90UT PID Control Module is installed.
22 This is applicable only when a GX90UT PID Control Module is installed.

I/O Modules

GX90XA

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XA</td>
<td>-04</td>
<td>Analog Input Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-06</td>
<td>6 channels (Type -H0 only)</td>
</tr>
<tr>
<td></td>
<td>-10</td>
<td>10 channels (Type -R1 only)</td>
</tr>
</tbody>
</table>

Type

- C1: Current, scanner type (isolated between channels)
- L1: DCV/TC/DI (400 VAC, 1 min), scanner type (isolated between channels)
- U2: Universal, solid state relay scanner type (3-wire RTD 6-terminal common)
- T1: DCV/TC/DI, electromagnetic relay scanner type (isolated between channels)
- H0: High-speed universal, individual A/D type (isolated between channels)
- R1: 4-wire RTD/resistance, scanner type (isolated between channels)
- V1: DCV/TC/DI, high withstand voltage scanner type (isolated between channels)

Area

- N: General

GX90XD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XD</td>
<td>-16</td>
<td>Digital Input Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-11</td>
<td>16 channels</td>
</tr>
</tbody>
</table>

Type

- N: Open collector/non-voltage, contact (shared common), Rated 5 VDC

Area

- N: General

GX90YD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90YD</td>
<td>-06</td>
<td>Digital Output Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-11</td>
<td>8 channels</td>
</tr>
</tbody>
</table>

Type

- N: Relay, SPDT (NO-C-NC)

Area

- N: General

GX90WD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90WD</td>
<td>-0806</td>
<td>Digital Input/Output Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-01</td>
<td>Input 8 channels, Output 6 channels</td>
</tr>
</tbody>
</table>

Type

- N: Open collector/non-voltage contact (shared common), Rated 5 VDC, Relay, SPDT (NO-C-NC)

Area

- N: General

1 Optional code /MT (MATH) required if using the pulse input.

I/O Base Unit (Expandable I/O)

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX80</td>
<td>-EX</td>
<td>I/O Base Unit</td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td>I/O Expansion</td>
</tr>
<tr>
<td>Area</td>
<td>N</td>
<td>General</td>
</tr>
<tr>
<td>Power supply</td>
<td>1</td>
<td>100 VAC, 240 VAC</td>
</tr>
<tr>
<td>Power cord</td>
<td>D</td>
<td>Power cord UL/CSA standard</td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>Power cord VDE standard</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Power cord AS standard</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>Power cord BS standard</td>
</tr>
<tr>
<td></td>
<td>T</td>
<td>Power cord GB standard</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Power cord NBR standard</td>
</tr>
<tr>
<td></td>
<td>W</td>
<td>Screw terminal, power cord not included</td>
</tr>
</tbody>
</table>

1 Include GX90EX (Expansion module), Stopper (antiskid rubber)

2 Intended use for panel or rack mounting only.

I/O Expansion Module (Expansion Module)

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90EX</td>
<td>-02</td>
<td>I/O Expansion Module</td>
</tr>
<tr>
<td>Port</td>
<td></td>
<td>2 ports</td>
</tr>
<tr>
<td>Type</td>
<td>-TP1</td>
<td>Twisted pair cable</td>
</tr>
<tr>
<td>Area</td>
<td>-N</td>
<td>General</td>
</tr>
</tbody>
</table>

I/O Modules

GX90XA

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XA</td>
<td>-04</td>
<td>Analog Input Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-06</td>
<td>6 channels (Type -H0 only)</td>
</tr>
<tr>
<td></td>
<td>-10</td>
<td>10 channels (Type -R1 only)</td>
</tr>
</tbody>
</table>

Type

- C1: Current, scanner type (isolated between channels)
- L1: DCV/TC/DI (400 VAC, 1 min), scanner type (isolated between channels)
- U2: Universal, solid state relay scanner type (3-wire RTD 6-terminal common)
- T1: DCV/TC/DI, electromagnetic relay scanner type (isolated between channels)
- H0: High-speed universal, individual A/D type (isolated between channels)
- R1: 4-wire RTD/resistance, scanner type (isolated between channels)
- V1: DCV/TC/DI, high withstand voltage scanner type (isolated between channels)

Area

- N: General

GX90XD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XD</td>
<td>-16</td>
<td>Digital Input Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-11</td>
<td>16 channels</td>
</tr>
</tbody>
</table>

Type

- N: Open collector/non-voltage, contact (shared common), Rated 5 VDC

Area

- N: General

GX90YD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90YD</td>
<td>-06</td>
<td>Digital Output Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-11</td>
<td>8 channels</td>
</tr>
</tbody>
</table>

Type

- N: Relay, SPDT (NO-C-NC)

Area

- N: General

GX90WD

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90WD</td>
<td>-0806</td>
<td>Digital Input/Output Module</td>
</tr>
<tr>
<td>Channels</td>
<td>-01</td>
<td>Input 8 channels, Output 6 channels</td>
</tr>
</tbody>
</table>

Type

- N: Open collector/non-voltage contact (shared common), Rated 5 VDC, Relay, SPDT (NO-C-NC)

Area

- N: General

1 Optional code /MT (MATH) required if using the pulse input.
GX90XP

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XP</td>
<td>-10</td>
<td>Pulse Input Module 1</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
<td>10 channels</td>
</tr>
<tr>
<td>Type</td>
<td>-11</td>
<td>DC voltage/Open collector/Non-voltage, contact (shared common), Rated 5 VDC</td>
</tr>
<tr>
<td>-</td>
<td>N</td>
<td>Always N</td>
</tr>
<tr>
<td>Terminal type</td>
<td>-3</td>
<td>Screw terminal (M3)</td>
</tr>
<tr>
<td>-</td>
<td>C</td>
<td>Clamp terminal</td>
</tr>
<tr>
<td>Area</td>
<td>N</td>
<td>General</td>
</tr>
</tbody>
</table>

1 The /MT option (computation) is required to perform pulse integration.

GX90YA

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90YA</td>
<td>-04</td>
<td>Analog Output Module</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
<td>4 channels</td>
</tr>
<tr>
<td>Type</td>
<td>-C1</td>
<td>Current output (isolated between channels)</td>
</tr>
<tr>
<td>-</td>
<td>N</td>
<td>Always N</td>
</tr>
<tr>
<td>Terminal type</td>
<td>-3</td>
<td>Screw terminal (M3)</td>
</tr>
<tr>
<td>-</td>
<td>C</td>
<td>Clamp terminal</td>
</tr>
<tr>
<td>Area</td>
<td>N</td>
<td>General</td>
</tr>
</tbody>
</table>

GX90UT

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90UT</td>
<td>-02</td>
<td>PID Control Module</td>
</tr>
<tr>
<td>Number of loops</td>
<td>-11</td>
<td>2 loops</td>
</tr>
<tr>
<td>Function</td>
<td></td>
<td>DI 8 points, DO 8 points</td>
</tr>
<tr>
<td>-</td>
<td>N</td>
<td>Always N</td>
</tr>
<tr>
<td>Terminal type</td>
<td>-3</td>
<td>Screw terminal (M3)</td>
</tr>
<tr>
<td>-</td>
<td>C</td>
<td>Clamp terminal</td>
</tr>
<tr>
<td>Area</td>
<td>N</td>
<td>General</td>
</tr>
</tbody>
</table>

■ Customized Product
For customized product, the product is identified by the option code of /S# (where ‘#’ is a number).
Contact your supplier in case your instrument has option /S#, and you are not in the possession of IM [Model code]-S# (where [Model code] means, for example, GX90XA).

Standard Accessories
The instrument is shipped with the following accessories. Make sure that all accessories are present and undamaged.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Part Number/Model</th>
<th>Qty.</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mounting bracket</td>
<td>B8740DY</td>
<td>2</td>
<td>GX10/GX20 only</td>
</tr>
<tr>
<td>2</td>
<td>SD memory card</td>
<td>773001</td>
<td>1</td>
<td>1GB</td>
</tr>
<tr>
<td>3</td>
<td>Dummy cover</td>
<td>B8740CZ</td>
<td></td>
<td>For empty slots</td>
</tr>
<tr>
<td>4</td>
<td>Tag plate</td>
<td>B8740FE</td>
<td>1</td>
<td>GP20</td>
</tr>
<tr>
<td></td>
<td>B8740ME</td>
<td></td>
<td>1</td>
<td>GX10</td>
</tr>
<tr>
<td></td>
<td>B8741FE</td>
<td></td>
<td>1</td>
<td>GP10</td>
</tr>
<tr>
<td>5</td>
<td>Sheet</td>
<td>B8740FF</td>
<td>1</td>
<td>GX20</td>
</tr>
<tr>
<td></td>
<td>B8740MF</td>
<td></td>
<td>1</td>
<td>GP20</td>
</tr>
<tr>
<td></td>
<td>B8741FF</td>
<td></td>
<td>1</td>
<td>GX10</td>
</tr>
<tr>
<td></td>
<td>B8741MF</td>
<td></td>
<td>1</td>
<td>GP10</td>
</tr>
<tr>
<td>6</td>
<td>Stylus</td>
<td>B8740BZ</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Power cord</td>
<td>A1006WD</td>
<td>1</td>
<td>O: Power cord UL, CSA std ¹</td>
</tr>
<tr>
<td></td>
<td>A1009WD</td>
<td></td>
<td>1</td>
<td>F: Power cord VDE std ¹</td>
</tr>
<tr>
<td></td>
<td>A1024WD</td>
<td></td>
<td>1</td>
<td>R: Power cord AS std ¹</td>
</tr>
<tr>
<td></td>
<td>A1054WD</td>
<td></td>
<td>1</td>
<td>Q: Power cord BS std ¹</td>
</tr>
<tr>
<td></td>
<td>A1064WD</td>
<td></td>
<td>1</td>
<td>H: Power cord GB std ¹</td>
</tr>
<tr>
<td></td>
<td>A1088WD</td>
<td></td>
<td>1</td>
<td>N: Power cord NBR std ¹</td>
</tr>
<tr>
<td>8</td>
<td>Manual</td>
<td>IM 04L51B01-02EN</td>
<td>1</td>
<td>First Step Guide (This manual)</td>
</tr>
<tr>
<td></td>
<td>IM 04L61B01-11EN</td>
<td></td>
<td>1</td>
<td>Regarding the Downloading and Installing for the Software, Manuals and Labels/About the Usage of Open Source Software</td>
</tr>
</tbody>
</table>

1 Except GP10 power supply suffix code: 2

Optional Accessories (Sold separately)

<table>
<thead>
<tr>
<th>Name</th>
<th>Part Number/Model</th>
<th>Minimum Qty</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting bracket</td>
<td>B8740DY</td>
<td>2</td>
<td>GX10/GX20 only</td>
</tr>
<tr>
<td>SD memory card</td>
<td>773001</td>
<td>1</td>
<td>1GB</td>
</tr>
<tr>
<td>Stylus</td>
<td>B8740BZ</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Shunt resistor (for M3 screw terminal)</td>
<td>415940</td>
<td>1</td>
<td>250 Ω ± 0.1%</td>
</tr>
<tr>
<td>Shunt resistor (for clamp terminal)</td>
<td>415941</td>
<td>1</td>
<td>100 Ω ± 0.1%</td>
</tr>
<tr>
<td>Shunt resistor (for clamp terminal)</td>
<td>415942</td>
<td>1</td>
<td>10 Ω ± 0.1%</td>
</tr>
<tr>
<td>Dummy cover</td>
<td>B8740CZ</td>
<td>1</td>
<td>For module slot</td>
</tr>
</tbody>
</table>

IM 04L51B01-02EN 9
**GX/GP Style Number, Release Number, and Firmware Version Number**

- **Style number**: The GX/GP hardware ID number. This number is written on the name plate (H column).
- **Release number**: The GX/GP firmware ID number. This number is written on the name plate (S column). This number matches with the integer part of the firmware version number.
- **Example**: If the firmware version number is 1.01, the release number is 1.

- **Firmware version number**: This number appears on the system information screen of the GX/GP. To view the number, see section 2.3, “Displaying Various Types of Information” in the User’s Manual, IM04L51B01-01EN.

**Conventions Used in This Manual**

- This manual covers information regarding GX/GPs whose display language is English.
- For details on the language setting, see the Paperless Recorder User’s Manual, IM04L51B01-01EN.
- **Unit**
  - K: Denotes 1024. Example: 768K (file size)
  - k: Denotes 1000.

The notes and cautions in this manual are indicated using the following symbols.

![Warning Symbol]

**WARNING**

Calls attention to actions or conditions that could cause serious or fatal injury to the user, and precautions that can be taken to prevent such occurrences.

**CAUTION**

Calls attention to actions or conditions that could cause light injury to the user or damage to the instrument or user’s data, and precautions that can be taken to prevent such occurrences.

**Note**

Calls attention to information that is important for proper operation of the instrument.

---

<table>
<thead>
<tr>
<th>Type Suffix Code</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>-U2</td>
<td>Universal</td>
</tr>
<tr>
<td>-C1</td>
<td>Current (mA)</td>
</tr>
<tr>
<td>-L1</td>
<td>Low withstand voltage relay</td>
</tr>
<tr>
<td>-T1</td>
<td>Electromagnetic relay</td>
</tr>
<tr>
<td>-H0</td>
<td>High-speed universal or High speed AI</td>
</tr>
<tr>
<td>-R1</td>
<td>4-wire RTD/resistance</td>
</tr>
<tr>
<td>-V1</td>
<td>High withstand voltage</td>
</tr>
</tbody>
</table>
Protection of Environment
Control of Pollution Caused by the Product

This is an explanation for the product based on “Control of pollution caused by Electronic Information Products” in the People’s Republic of China.

产品中有毒有害物质或元素的名称及含量

<table>
<thead>
<tr>
<th>部件名称</th>
<th>铅 (Pb)</th>
<th>汞 (Hg)</th>
<th>镉 (Cd)</th>
<th>六价铬 (Cr6+)</th>
<th>多溴联苯 (PBB)</th>
<th>多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>印制电路板</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>内部接线材料</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>外壳/机箱</td>
<td>塑料</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>电源</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>正面边框</td>
<td>塑料</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>标准附件/可选附件</td>
<td>显示器 (LCD)</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>安装支架</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>电源线(GP10/GP20/GX60（的插口型）)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SD 存储卡</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>分流电阻</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

✓: 表示该部件的所有均质材料中的有毒有害物质或元素的含量均低于GB/T 26572 标准所规定的限量要求。
N/A: 表示该部件中至少有一种均质材料中的有毒有害物质或元素的含量超过GB/T 26572 标准所规定的限量要求。
本产品的部分部件包含RoHS指令中的限用物质,但是其使用方法不受该指令限制。

Some parts of this product include the restricted substances of RoHS Directive, but their applications are under the exemption of the directive.

该标志为环境保护使用期限,根据SJ/T11364，适用于在中国（台湾、香港、澳门除外）销售的电子电气产品，只要遵守该产品的安全及使用注意事项，从产品生产之日起至该标志所示年限内，不会因为产品中的有害物质外泄或突变而导致环境污染或对人身财产产生重大影响。

注释) 该标志所示年限为“环境保护使用期限”，并非产品的保质期。另外，关于更换部件的推荐更换周期，请参阅使用说明书。

Waste Electrical and Electronic Equipment (WEEE), Directive

This is an explanation of how to dispose of this product based on Waste Electrical and Electronic Equipment (WEEE), Directive. This directive is only valid in the EU.

- Marking
  This product complies with the WEEE Directive marking requirement. This marking indicates that you must not discard this electrical/electronic product in domestic household waste.
- Product Category
  With reference to the equipment types in the WEEE directive, this product is classified as a “Small equipment” product.
  Do not dispose in domestic household waste.
  When disposing products in the EU, contact your local Yokogawa Europe B.V. office.

How to Dispose the Batteries

This is an explanation about the EU Battery Directive. This directive is only valid in the EU.

Batteries are included in this product. Batteries incorporated into this product cannot be removed by yourself. Dispose them together with this product. When you dispose this product in the EU, contact your local Yokogawa Europe B.V. office. Do not dispose them as domestic household waste.

Battery type: Lithium battery

Notice: The symbol (see above) means they shall be sorted out and collected as ordained in ANNEX II in DIRECTIVE 2006/66/EC.
Functional Overview

Overview
The GX/GP is a paperless recorder that can display measured data in real time on its touch screen and save the data in an SD memory card.

A Variety of Source Signals
The GX/GP can connect to DC voltage, TC, RTD, ON/OFF, DC current (mA) and pulse inputs and measure temperature, flow rate, and other parameters. The GX/GP acquires data by sampling input signals at the set scan interval. The shortest scan interval is 1 ms (High-speed AI module). Up to four alarm conditions can be specified on each measurement channel.

Expandable Module Construction
The I/O section is modular, so you can configure your system according to the input types and number of measurement points.

<table>
<thead>
<tr>
<th>Model</th>
<th>Name</th>
<th>Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>GX90XA</td>
<td>Analog input module</td>
<td>4/6/10</td>
</tr>
<tr>
<td>GX90XD</td>
<td>Digital input module</td>
<td>16</td>
</tr>
<tr>
<td>GX90YD</td>
<td>Digital output module</td>
<td>6</td>
</tr>
<tr>
<td>GX90WD</td>
<td>Digital Input/Output Module</td>
<td>Input : 8 , Output : 6</td>
</tr>
<tr>
<td>GX90XP</td>
<td>Pulse Input Module</td>
<td>10</td>
</tr>
<tr>
<td>GX90YA</td>
<td>Analog output module</td>
<td>4</td>
</tr>
<tr>
<td>GX90UT</td>
<td>PID Control Module</td>
<td>26</td>
</tr>
</tbody>
</table>

• Up to 10 modules can be installed in the GX20/GP20.
• Up to 3 modules can be installed in the GX10/GP10.
• Different modules can coexist.

* Up to nine modules for the GX20/GP20 and two modules for the GX10/GP10 when an GX60 is connected.

GX60 Connection and Multichannel Measurement
An GX60 I/O can be connected to the GX20/GP20 to measure up to 450 channels. On the standard type, you can connect the GX60 to allocate input sections at different locations.

<table>
<thead>
<tr>
<th>Item</th>
<th>GX/GP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Type</td>
<td></td>
</tr>
<tr>
<td>Maximum number of connectable GX60</td>
<td>6</td>
</tr>
<tr>
<td>Maximum number of I/O modules (main unit + GX60)</td>
<td>10 ^1</td>
</tr>
<tr>
<td>Maximum number of I/O channels</td>
<td>100</td>
</tr>
<tr>
<td>Large Memory Type</td>
<td></td>
</tr>
<tr>
<td>Maximum number of connectable GX60</td>
<td>6</td>
</tr>
<tr>
<td>Maximum number of I/O modules (main unit + GX60)</td>
<td>45 ^2</td>
</tr>
<tr>
<td>Maximum number of I/O channels</td>
<td>500</td>
</tr>
</tbody>
</table>

1 2 on the rear of the GX10/GP10, 9 on the rear of the GX20/GP20.
2 9 on the rear of the GX20/GP20.
High-speed Measurement, Dual Interval Measurement (Measurement mode)

The GX/GP has measurement modes to allow high-speed measurement and simultaneous measurement of slow and fast signals.

In high-speed measurement, a high-speed AI module can be installed to achieve measurement at the shortest interval of 1 ms.

In dual interval measurement, measurement can be performed by two measurement groups with different scan intervals.

Various measurements can be performed by changing the measurement mode according to the measurement target and measurement conditions.

Loop Control and Program Control Function (/PG Option)

By installing a PID Control Module (GX90UT), you can perform PID control of up to 20 loops (up to 6 loops for the GX10/GP10). In addition to control loop monitoring and the control group screen for convenient operation, adjustment using the tuning screen is available.

Adding the /PG option to the GX/GP main unit allows 99 patterns and 99 segments of program patterns to be stored in the main unit. Further, 32 time events can be set.

Data Storage

There are two ways to store data. One way is to record measured data at all times (display data and event data). The other way is to record only when events, such as alarms, occur (event data). Measured data is saved to the internal memory at the specified interval. Data in the internal memory can be saved to the SD memory card automatically or manually. Measured data can be transferred automatically to an FTP server over an Ethernet connection.

A Variety of Display Functions

Measured data can be displayed in groups as trend waveforms, values, and bar graphs. There is also an overview display that you can monitor all channels on a single screen.

Custom Display (Option, /CG)

You can control and monitor on a custom display consisting of digital, trend, bar graph, and other components and images that are laid out freely. Custom displays are created using DAQStudio (DxA170), a software application sold separately.

Displays that you create are loaded into the GX/GP from DAQStudio or from an external storage medium.
Functional Overview

Touch Screen
The GX/GP touch screen enables intuitive operation. You can tap the icons of setup and operation items as well as scroll and zoom in on and out of waveforms by directly touching the screen. In addition, when you are working on-site, you can operate the GX/GP with your gloves on.

Touch Operations
- **Tap**
  Touch the screen with a pen or finger.
- **Drag**
  Touch the screen with a pen or finger and move.
- **Flick**
  Wipe a pen or finger across the screen.
- **Pinch apart/together**
  Touch the screen with two fingers and move them apart or together.

Freehand Messages
You can use the touch pen or your finger to write text and draw marks freely in the waveform area. The messages that you write can easily be displayed from information displays such as the message summary and memory summary.

Versatile Network Functions and Software
The Ethernet interface enables you to monitor the GX/GP from a Web browser. E-mails can be sent through this interface when alarms and other events occur. In addition, you can use the Modbus protocol to read data from other devices on the network and display it. As for the software, Universal Viewer can be used to view measured data and convert the data into other data formats.
### Other Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math function (/MT option)</td>
<td>Expressions can be assigned to math channels to perform various computations. Logic math can output calculated results as 0 or 1 to DOs or internal switches. Computation is performed regardless of the math start/stop condition.</td>
</tr>
<tr>
<td>FAIL output (/FL option)</td>
<td>This function transmits alarms when the GX/GP fails.</td>
</tr>
<tr>
<td>Security function</td>
<td>You can allow only registered users to use the GX/GP. In addition, certain operations can be prohibited.</td>
</tr>
<tr>
<td>Remote control</td>
<td>This function executes specified operations by combining input modules and the event action function.</td>
</tr>
<tr>
<td>Advanced security function (/AS option)</td>
<td>A security function that complies with US FDA 21CFR Part11. Electronic signatures can be added to measured data.</td>
</tr>
<tr>
<td>EtherNet/IP communication (/E1 option)</td>
<td>This function is equipped with a server function that enables communication with EtherNet/IP devices.</td>
</tr>
<tr>
<td>WT communication (/E2 option)</td>
<td>This function acquires measured and calculated data from a power meter and displays and records it along with the measured values of the GX/GP.</td>
</tr>
<tr>
<td>LOG scale (/LG option)</td>
<td>This function measures logarithmic voltage that has been converted from a physical value, scales the voltage, and displays the resultant data.</td>
</tr>
<tr>
<td>Aerospace heat treatment (/AH option)</td>
<td>Supports aerospace heat treatment measurements and NADCAP AMS2750E compliant recording and reporting. Manage user-defined schedules for periodical execution.</td>
</tr>
<tr>
<td>Multi batch (/BT option)</td>
<td>Start and stop recording separately for each batch and create data files for each batch.</td>
</tr>
<tr>
<td>OPC-UA server (/E3 option)</td>
<td>Equipped with an OPC-UA server function. GX/GP measurement data can be retrieved directly from a host system, such as SCADA and MES.</td>
</tr>
<tr>
<td>SLMP communication (/E4 option)</td>
<td>Equipped with a client function for the MC protocol. Connection to Mitsubishi Electric PLCs can be established easily.</td>
</tr>
</tbody>
</table>
### Functional Overview

#### System Configuration

You can configure a GX/GP system as shown below.

---

**PC**
- Network printer
- Temperature Controller
- Recorder
- Ethernet
- DC loop power supply
- DIRTD TC/DCV
- mA
- Pulse

**Signal input**
- RTD TC/DCV
- DI
- Pulse
- mA

**Remote input**

**Signal output**
- Alarm output
- Manual DO output
- Analog output
- FAIL/status output*

**Control input**
- RTD TC/DCV
- DI

**Control output**
- mA
- Pulse

**Digital input/output**
- DO out
- Alarm out
- DI input

---

**GX20**
- USB port*
- SD memory card
- USB memory
- Mouse
- Bar code reader
- Monitor*

**GX10**
- USB port*
- Monitor*

**GX60**
- Max 6 unit

**GP20**
- Manual DO output
- Analog output

**GP10**
- Bar code reader
- Monitor*

---

* Option

---

**YOKOGAWA**

Web site
- Download PC software
- Download user’s manuals

---

**PC**
- Network printer
- Temperature Controller
- Recorder
- Ethernet
- DC loop power supply
- DIRTD TC/DCV
- mA
- Pulse

**Signal input**
- RTD TC/DCV
- DI
- Pulse
- mA

**Remote input**

**Signal output**
- Alarm output
- Manual DO output
- Analog output
- FAIL/status output*

**Control input**
- RTD TC/DCV
- DI

**Control output**
- mA
- Pulse

**Digital input/output**
- DO out
- Alarm out
- DI input

---

**GX20**
- USB port*
- SD memory card
- USB memory
- Mouse
- Bar code reader
- Monitor*

**GX10**
- USB port*
- Monitor*

**GX60**
- Max 6 unit

**GP20**
- Manual DO output
- Analog output

**GP10**
- Bar code reader
- Monitor*

---

* Option
Component Names

GX20/GX10

**GX20 front panel**
- LCD
  - Shows the trend display and other displays and the setup screen
- START/STOP key
  - Starts and stops recording
- MENU key
  - Press this once to show a menu for accessing various screens.
- Stylus pen (touch pen)
- USB port (/UH option)
  - USB2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.
- SD memory card slot
  - SD memory card (up to 32 GB)
  - Format: FAT32 or FAT16
  - A 1 GB card is included.
- USB port (/UH option)
- Connect I/O signals.
- GX10, GP10: 3 slots (0 to 2)
- GX20, GP20: 10 slots (0 to 9)
- RS-422/485 terminal
- I/O module slot
  - GX10, GP10: 3 slots (0 to 2)
  - GX20, GP20: 10 slots (0 to 9)
- I/O module
  - Connect I/O signals.
- Power inlet (GP10/GP20)
- Serial port (/IC2 option)
  - RS-232 terminal
- Power supply terminal and protective ground terminal (GX10/GX20)
- Serial port (/IC3 option)
  - RS-422/485 terminal
- USB port (/UH option)
  - USB 2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.
- Ethernet port
  - 10BASE-T/100BASE-TX port
- FAIL output terminal (/FL option)
- VGA output connector (/D5 option)
  - Connects to an external monitor

**GX20 rear panel**
- Power switch
- Front door
- LCD
- MENU key
- Stylus pen (touch pen)
- USB 2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.
- SD memory card (up to 32 GB)
  - Format: FAT32 or FAT16
  - A 1 GB card is included.
- MENU key
  - Alarms are indicated with a red LED.
- Front door lock mechanism
  - A front door is locked/unlocked by a slide at the bottom.

**GX10 front panel**
- LCD
- POWER inlet
- ST(T)ART/STOP key
- SERIAL port
- SD memory card slot
- MENU key
- USB port (UH option)
  - USB2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.
  - SD memory card (up to 32 GB)
  - Format: FAT32 or FAT16
  - A 1 GB card is included.

**GX10 rear panel**
- LCD
- MENU key
- Stylus pen (touch pen)
- USB port (UH option)
  - USB 2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.
- SD memory card slot
- MENU key
  - Alarms are indicated with a red LED.
- Front door lock mechanism
  - A front door is locked/unlocked by a slide at the bottom.
- USB port (UH option)
- Connect I/O signals.
- I/O module slot
  - GX10, GP10: 3 slots (0 to 2)
  - GX20, GP20: 10 slots (0 to 9)
- I/O module
  - Connect I/O signals.
- Power inlet (GP10/GP20)
- Serial port (IC2 option)
  - RS-232 terminal
- Power supply terminal and protective ground terminal (GX10/GX20)
- Serial port (IC3 option)
  - RS-422/485 terminal
- USB port (UH option)
- Ethernet port
  - 10BASE-T/100BASE-TX port
- FAIL output terminal (FL option)
- VGA output connector (D5 option)
  - Connects to an external monitor

Use an off-the-shelf door lock key.
**Component Names**

**GP20/GP10**

- **GP20 front**
  - Handle
  - Power supply terminal (Power supply suffix code: 2)

- **GP20 rear**
  - Feet

- **GP10 front**
  - Handle

- **GP10 rear**
  - Power inlet

**GX60/GX90EX**

**GX60 I/O Base Unit (Expandable I/O)**

- I/O Module Slot
- Power Switch
- Power supply terminal and protective ground terminal or Power inlet

**GX90EX Expansion Module**

- 7 segment LED
- System status LED
- Setting switch (DIP switch)
- Connecting port EXBus status LED

Stopper (antiskid rubber)
Affix the included antiskid rubber to the location indicated in the figure.
Component Names

GX90XA Analog Input Module
M3 screw terminal
Clamp terminal
Terminal block release levers

GX90XD Digital Input Module
M3 screw terminal
Clamp terminal
Terminal block attachment screws

GX90YD Digital Output Module
M3 screw terminal
Terminal block attachment screws

GX90WD Digital Input/Output Module
M3 screw terminal

GX90XP Pulse Input Module
M3 screw terminal
Clamp terminal

GX90YA Analog Output Module
M3 screw terminal
Clamp terminal
Terminal block attachment screws
To prevent electric shock when you attach or remove terminal covers or terminal blocks, be sure that the power supply is turned off.

**Component Names**

**GX90UT PID Control Module**

M3 screw terminal

![Terminal block release levers](image)

**Removing and Attaching a Terminal Cover**

**Removing the Terminal Cover**

Loosen the screw at the bottom section of the terminal cover, and remove the cover.

**Attaching the Terminal Cover**

1. Insert the two hooks at the top section on the inside of the terminal cover into A, and push the bottom section of the terminal cover.
2. Fasten the screw at the bottom section of the terminal cover to fix the cover in place.
   Recommended tightening torque: 0.6 N•m

The shape of the cover varies depending on the module, but the procedure is the same.

**Removing and Attaching a Terminal Block**

**Removing the GX90XA Terminal Block**

Push down on the lever at the bottom section of the module, and pull the terminal block out.

**Attaching the GX90XA Terminal Block**

Insert the terminal block into the module, and push the lever firmly against the module (at the position indicated by the arrow in the figure).

For modules other than the GX90XA, you can use the attachment screw to remove and attach them.

Recommended torque for tightening the terminal block attachment screws: 0.1 N•m
When you are using the GX/GP for the first time, following the procedure below to quickly start measuring and recording.

**Operating Procedure**

Product user’s manuals can be downloaded or viewed at the following URL:


- Manuals for reference

1. Connect an GX60
   - To connect an GX60.

2. Install modules.
   - Not required if preinstalled
   - To connect an GX60, install the modules in the GX60.

3. Connect I/O signals and power.

4. Turn on the power.
   - When performing high-speed or dual interval measurement according to measurement conditions, change the measurement mode from Normal to High speed or Dual interval.

5. Setting the Measurement Mode
   - If preinstalled, modules are preconfigured.
   - If you rearrange the modules, connect an GX60 or change the measurement mode, reconfigure.

6. Make the GX/GP recognize the modules (GX/GP reconfiguration).

7. Set the date and time.*
   - If you need to set the time zone or DST (Daylight Saving Time) or both, do so before setting the date and time.

8. Configure signal inputs.

9. Configure functions as necessary.

10. Start measuring/recording.
    - For details on various settings, see the Paperless Recorder User’s Manual (IM 04L51B01-01EN), provided as an electronic manual.
Operating Procedure

1. Install an expansion module (GX90EX) into the GX/GP.

   GX90EX
   GX10/GP10: Slot 2
   GX20/GP20: Slot 9

2. GX60 address setting

   Setting switch (DIP switch)

3. Connect the LAN cable between GX/GP and GX60.

   GX90EX

---

2. Modules not installed

   Dummy covers are attached to empty slots (with screws).

   * Recommended tightening torque: 0.6 Nm

---

3. GX60

   Ex GX/GP

   Power inlet on the GP10/GP20/GX60 (Power inlet type)

   Ex GX/GP

---

4. GX60

   Power switch

---

7. Set the date and time*

   MENU key

   Common menu tab

   Browse tab

---

5. Set the measurement mode

   Reconfiguration (Initialize)

---


   or

   Recording stopped

   Alternates

   Lit in blue
   Running
   (No alarm)

   Lit in red
   Alarm activated

   Off: Power off

   To open, push the front door down and pull it toward you.

   * Recommended tightening torque: 0.6 Nm

---

To prevent electric shock when wiring, make sure that the power supply is turned off.
**Installation and Wiring**

### Installation Location

**Install the GX/GP indoors in an environment that meets the following conditions:**

- If hazardous external voltage (30 V AC or 60 V DC or more) is applied to the output terminals of the GP10/GP20/GX60, be sure to install it in a location where people cannot touch the terminals carelessly or in a panel.
- The GX10/GX20 is designed to be installed in an instrumentation panel.
- This product is designed as open equipment under the CSA/UL/EN 61010-2-201 standards. In order to comply with these standards, install it as follows:
  - The GX10/GX20 is designed to be installed in an instrumentation panel.
  - Install it in a location where people cannot touch the terminals carelessly.
  - To make the GP10/GP20 comply with the relevant standard, support the parts of the device other than the front-panel control area with an instrumentation panel or the like, and install it in a location where people cannot touch the terminals carelessly or in a panel.
  - Install the GX60/GM unit in a panel with a door.
  - The instrumentation panel or panel used for support must comply with CSA/UL/EN 61010-2-201 or must be at least IP1X (degrees of protection) and at least IK09.

- **Well-ventilated location**
  
  To prevent overheating, install the GX/GP in a well-ventilated location. For the panel cut dimensions when arranging multiple GXs, see the next page. When other instruments are installed next to the GX, follow the panel cut dimensions to provide adequate space around the GX. In the case of the portable type, we recommend that you provide at least 50 mm of space from the left, right, and top panels.

### Minimal mechanical vibrations

- Install the GX/GP in a location that has minimal mechanical vibrations. Installing the GX/GP in a location that is subject to large levels of mechanical vibration will not only put added stress on its components, it may also impede ordinary measurement.

### Level Location

- Install the GX/GP in a level location so that it is not slanted to the left or the right (however, the GX/GP can be inclined up to 30 degrees backward for panel mounting).

### Note

Condensation may form when moving the GX/GP from a low temperature or humidity environment to a high temperature or humidity environment, or when there is a sudden change in temperature. Temperature or humidity changes may also result in thermocouple measurement errors. In these kinds of circumstances, wait for at least an hour before using the GX/GP, to acclimate it to the surrounding environment. The GP20 may tip over if it is tilted more than 10 degrees, front and back.

### Do Not Install the Instrument in the Following Places

- **Outdoors**
  - In direct sunlight or near heat sources
  
  Install the GX/GP in a place that is near room temperature (23°C) and that is not subject to large temperature fluctuations. Placing the GX/GP in direct sunlight or near heat sources can cause adverse effects on the internal circuitry.
  
  - Where an excessive amount of soot, steam, moisture, dust, or corrosive gases are present
  
  Soot, steam, moisture, dust, and corrosive gases will adversely affect the GX/GP. Avoid installing the GX/GP in such locations.
  
  - Near strong magnetic field sources
  
  Do not bring magnets or instruments that produce electromagnetic fields close to the GX/GP. Operating the GX/GP near strong magnetic fields can cause measurement errors.
  
  - Where the display is difficult to see
  
  The GX/GP uses an LCD screen, so it is difficult to view the display from an extreme angle. Install the GX/GP so that the user can view the display directly from the front.
**Installation Procedure**

*CAUTION*

- Using more than the appropriate torque to tighten the screws can deform the case or damage the brackets.
- Be sure not to insert foreign objects or tools into the case through the mounting bracket holes.
- When you attach the rubber packing, be sure that no portion of it gets wedged between the GX and the panel. If the rubber packing is not attached properly, you will not be able to achieve sufficient dust proofing or waterproofing.

**Installation Procedure for the GX10/GX20**

Use a steel panel that is 2 mm to 26 mm thick.

1. Insert the GX through the front of the panel.
2. Mount the GX to the panel using the included mounting brackets as described below.
   - Use two mounting brackets to support the top and bottom or the left and right sides of the case (remove the stickers that are covering the holes before you attach the brackets).
   - The recommended tightening torque for the mounting screws is 0.7 to 0.9 N•m.
   - Follow the procedure below to mount the GX to the panel.
     - First, attach the two mounting brackets and temporarily tighten the mounting screws.
     - Next, fix the GX in place by tightening the mounting screws with the appropriate torque. When the GX is approximately perpendicular to the panel, press the mounting brackets so that they are in contact with the case, and fully tighten the mounting screws.

**Note**

To achieve sufficient dust proofing and waterproofing, mount the GX in the middle of the panel cut out.

**Installation Procedure for the GX60**

Use a steel panel that is at least 2 mm thick.

1. Make 6 holes in the panel for the six M4 screws.
2. Fix the unit in place by fastening M4 screws to the six mounting screw holes. The recommended tightening torque for the screws is 0.7 to 0.9 N•m.

---

**External Dimensions and Panel Cut Dimensions**

**GX20 External Dimensions**

Unit: mm (approx. inch)

<table>
<thead>
<tr>
<th>Dimension</th>
<th>(Before attaching)</th>
<th>(After attaching)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>280.2 (11.03)</td>
<td>288 (11.34)</td>
</tr>
<tr>
<td>Height</td>
<td>295.2 (11.62)</td>
<td>288 (11.34)</td>
</tr>
<tr>
<td>Depth</td>
<td>144 (5.67)</td>
<td>144 (5.67)</td>
</tr>
</tbody>
</table>

*1: With modules  *2: Without modules

**Panel cut dimensions**

- 281 1/2 (11.06)
- 361 min. (14.21)

**25**
Installation and Wiring

**GX10 External Dimensions**

Unit: mm (approx. inch)  
Unless otherwise specified, tolerance is ±3% (however, tolerance is ±0.3 mm when below 10 mm).

(Dimensions before attaching the mounting bracket)

<table>
<thead>
<tr>
<th>Units</th>
<th>L(_1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>282 (11.10)</td>
</tr>
<tr>
<td>3</td>
<td>426 (16.77)</td>
</tr>
<tr>
<td>4</td>
<td>570 (22.44)</td>
</tr>
<tr>
<td>5</td>
<td>714 (28.11)</td>
</tr>
<tr>
<td>6</td>
<td>858 (33.78)</td>
</tr>
<tr>
<td>7</td>
<td>1002 (39.45)</td>
</tr>
<tr>
<td>8</td>
<td>1146 (45.12)</td>
</tr>
<tr>
<td>9</td>
<td>1290 (50.79)</td>
</tr>
<tr>
<td>10</td>
<td>1434 (56.46)</td>
</tr>
<tr>
<td>n</td>
<td>(144(\times)n)-6</td>
</tr>
</tbody>
</table>

(Dimensions after attaching the mounting bracket)

*1: With modules  
*2: Without modules

**Side-by-side mounting**

Vertically: max. 3 units

When using the stand, the GP10 will face 12 degrees upward.

**GP20 External Dimensions**

Unit: mm (approx. inch)  
Unless otherwise specified, tolerance is ±3% (however, tolerance is ±0.3 mm when below 10 mm).

**GP10 External Dimensions**

Unit: mm (approx. inch)  
Unless otherwise specified, tolerance is ±3% (however, tolerance is ±0.3 mm when below 10 mm).

When using the stand, the GP10 will face 12 degrees upward.
**GX60 Dimensions**

**Power supply terminal type**

**Power inlet type**

**With modules**

Unit: mm (approx. inch)

Unless otherwise specified, tolerance is ±3% (however, tolerance is ±0.3 mm when below 10 mm).
**Installation and Wiring**

**Connect an GX60**

**Installing an Expansion Module into the GX/GP**
When installing an expansion module into the GX/GP or setting dipswitches, turn off the GX/GP and the GX60.

1. Install an expansion module into slot 9 or 2 of the GX/GP.

2. Set dipswitch 8 of the expansion module to “ON” (master).
   
   **Set the unit number to 0.**
   
   (Default: 0)

**Setting the Unit Number of the GX60**
The factory default unit number of the expansion module is 0. Use dipswitches 1 to 4 to set the unit number (1 to 6).

<table>
<thead>
<tr>
<th>Unit number</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>1</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>0*</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

1. The factory default setting. Unit number “0” is reserved for the expansion module that is installed into the GX/GP.

**Fixing the Data Rate to 10 Mbps**
To fix the data rate to 10 Mbps, set dipswitch 7 to “ON”.

**Connect an GX60**
Connect the expansion module installed in the GX/GP to the expansion modules of each expansion unit using Ethernet STP (shielded) cables. Only cascaded connection is supported. Maximum communication distance is 100 m. Distance extension through HUB connection or LAN repeaters is not possible.

**Functions of Expansion Module Components**

- 7 segment LED
- System status LED
- Setting switch (DIP switch)
- Connecting port
- EXBus status LED

**7 segment LED**
Displays the unit number and operation errors of the GX/GP and GX60
- Unit number indication
  Displays the unit number (00 to 06).
- Operation error indication
  Displays error codes. Ex (where x is a one digit number or an alphabet letter) will blink. For details on error codes, see “Expansion Module Error Codes” in section 5.2.1, “Messages” of the User’s Manual (IM 04L51B01-01EN).

  * If an “Fx” indication is displayed, servicing is necessary. Contact your nearest YOKOGAWA dealer for repairs.

**System Status Display LED**
Three LEDs indicate the operating status of the expansion module.

<table>
<thead>
<tr>
<th>Status display LED</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY</td>
<td>Green</td>
<td>Illuminates during normal operation. Turns off when during a failure.</td>
</tr>
<tr>
<td>MAIN</td>
<td>Green</td>
<td>Illuminates during master I/O expansion operation.</td>
</tr>
<tr>
<td>FAIL</td>
<td>RED</td>
<td>Illuminates during an error.</td>
</tr>
</tbody>
</table>
Installation and Wiring

Limit to the Number of GX/GP Main Unit Modules

• When GX90XA-04-H0 and GX90YA are included

<table>
<thead>
<tr>
<th>Module</th>
<th>No Limit</th>
<th>No Limit*</th>
<th>9</th>
<th>9</th>
<th>9</th>
<th>9</th>
</tr>
</thead>
</table>

* Up to two modules for 12 V DC models (power supply suffix code: 2)

• When GX90UT is included

<table>
<thead>
<tr>
<th>Module</th>
<th>No Limit</th>
<th>No Limit*</th>
<th>8</th>
<th>8</th>
<th>8</th>
<th>8</th>
</tr>
</thead>
</table>

* Up to two modules for 12 V DC models (power supply suffix code: 2)

Limit on Modules

• Up to 10 modules consisting of GX90YD, GX90WD, and GX90UT can be installed into the system.

• One GX90WD module can be installed in a GX. One module can be installed in a GX60 (expandable I/O) and each GM sub unit.

• One GX90YA module can be installed in a GX10. Two modules can be installed in each of the GX20, GX60 (expandable I/O) and GM sub unit.

• Up to 10 GX90YA modules can be installed in a GX10/GX20-1 system and up to 12 in a GX20-2 system.

• If the measurement mode is High speed, only GX90XA-04-H0 (high-speed AI), GX90XD (DI), and GX90WD (DIO) are detected. DI and DIO are fixed to remote mode. Measurement and recording are not possible.

• If the measurement mode is Dual interval, GX90UT is not detected.

Notes on Module Installation

• When the reference junction compensation of this product is used with the thermocouple input of a GX90XA-10-U2, GX90XA-10-L1, GX90XA-10-T1, GX90XA-10-V1, or GX90XA-04-H0, if the following module is installed to the right (slot with the smaller number) of the GX90XA module as seen from the GX rear panel, the reference junction compensation accuracy of that module may deviate from the guaranteed range (except when GX90XA-04-H0 is installed to adjacent slots).

• On the GX20, when the reference junction compensation of this product is used with the thermocouple input of a GX90XA-10-U2, GX90XA-10-L1, GX90XA-10-T1, GX90XA-10-V1, or GX90XA-04-H0, if the following module is installed above, below, to the right, or to the left (slot with the smaller number) of the GX90XA module as seen from the GX rear panel, the reference junction compensation accuracy of that module may deviate from the guaranteed range.

Setting Switches (Dipswitches)

Use the dipswitches to set the unit number of the GX60, 10 Mbps fixed mode, and operation mode.

Dipswitch settings

<table>
<thead>
<tr>
<th>Dipswitch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Switches between master I/O expansion and slave I/O expansion mode</td>
</tr>
<tr>
<td>7</td>
<td>10 Mbps/100Mbps</td>
</tr>
<tr>
<td>6</td>
<td>Always OFF (cannot be changed)</td>
</tr>
<tr>
<td>5</td>
<td>Always OFF (cannot be changed)</td>
</tr>
<tr>
<td>4</td>
<td>For unit number</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Port

The port is used to connect the GX60 to the GP/GX. Only cascaded connection is supported.

Installing and Removing I/O Modules

Installing a Module

1. As shown below, insert the module into the GX/GP slot and the GX60 slot.
2. Push the module in until you hear a click. Then, fasten the screw at the bottom section of the module.*

Removing a Module

1. Loosen the screw at the bottom section of the module.
2. While pressing down on the latch at the top of the module, pull the module out.

* Recommended torque for tightening the screws: 0.6 N•m
Installation and Wiring

Channel Names
A channel name consists of a unit number, slot number, and channel number.

<table>
<thead>
<tr>
<th>Unit number</th>
<th>Slot number</th>
<th>Channel number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
</tr>
</tbody>
</table>

Wiring

- To prevent electric shock while wiring, make sure that the power supply is turned off.
- If a voltage of more than 30 VAC or 60 VDC is to be applied to the output terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals to prevent the signal cables from slipping out when the screws become loose. Furthermore, use double-insulated cables (dielectric strength of 2300 VAC or more) for the signal cables on which a voltage of 30 VAC or 60 VDC or more is to be applied. For all other signal cables, use basic insulated cables (dielectric strength of 1390 VAC). To prevent electric shock, attach the terminal cover after wiring and make sure not to touch the terminals.
- Applying a strong tension to the input and output signal cables connected to the GX/GP may damage the cables or the GX/GP terminals. To avoid applying tension directly to the terminals, fix all cables to the rear of the mounting panel.
- To prevent fire, use signal cables with a temperature rating of 70°C or more.
- To avoid damage to the GX/GP, do not apply voltages that exceed the following values to the input terminals.

**GX90XA**
- Allowable input voltage: ±10 V DC for TC/DC voltage (1 V range or less)/RTD/DI (Contact), DC mA ±60 V DC for DC voltage (2 V to 50 V range), DI (voltage) input (except High-speed AI) ±120 V DC for DC voltage (2 to 100 V range) input, DI (voltage) (High-speed AI)
- Common mode voltage: ±60 VDC (under measurement category II conditions) High-speed AI only ±300 VAC rms (under measurement category II conditions) High withstand voltage only ±600 VAC rms / ±600 VDC (under measurement category II conditions)

**GX90XD, GX90WD**
- Allowable input voltage: +10 VDC
- Allowable input voltage: ±10 VDC
- Allowable input voltage: ±10 V DC for TC/DC voltage (1 V range or less)/RTD/DI (Contact), DC mA ±60 V DC for DC voltage (2 V range or more), DI (voltage)
- Common mode voltage: ±60 VDC (under measurement category II conditions)

The GX/GP is an installation category II product.
Precautions to Be Taken While Wiring

Take the following precautions when wiring the input/output signal cables.

- With a screw terminal, we recommend that you use a crimp-on lug with an insulation sleeve (M4 for power supply wiring, M3 for signal wiring).

\[\text{Crimp-on lug with an insulation sleeve}\]

Recommended signal wiring crimp-on lug (JST Mfg. Co., Ltd.)

- When not using crimp-on lug with an insulation sleeve, use a signal wire with a finished outside diameter of $\phi 5$ mm or less.

- With a clamp terminal, we recommend the following wire.

\[
\begin{align*}
\text{GX90XA} & \quad \text{Cross-sectional area} & 0.05 \, \text{mm}^2 \text{ to } 1.5 \, \text{mm}^2 \text{ (AWG30 to 16)} \\
& \quad \text{Stripped wire length} & 5 \text{ to } 6 \text{ mm} \\
\text{GX90XD, GX90XP, GX90YA} & \quad \text{Cross-sectional area} & 0.2 \, \text{mm}^2 \text{ to } 1.5 \, \text{mm}^2 \text{ (AWG24 to 16)} \\
& \quad \text{Stripped wire length} & 9 \text{ to } 10 \text{ mm} \\
\text{RS-422/485 (C3 option)} & \quad \text{Stripped wire length} & 6 \text{ to } 7 \text{ mm} \\
\text{FAIL output/status output (FL option)} & \quad \text{Cross-sectional area} & 0.33 \, \text{mm}^2 \text{ to } 2.0 \, \text{mm}^2 \text{ (AWG22 to 14)} \\
& \quad \text{Stripped wire length} & 10 \text{ to } 11 \text{ mm}
\end{align*}
\]

- Take measures to prevent noise from entering the measurement circuit.
  - Move the measurement circuit away from the power cable (power circuit) and ground circuit.
  - Ideally, the object being measured should not generate noise. However, if this is unavoidable, isolate the measurement circuit from the object. Also, ground the object being measured.
  - Shielded wires should be used to minimize the noise caused by electrostatic induction. Connect the shield to the ground terminal of the GX/GP as necessary (make sure you are not grounding at two points).
  - To minimize noise caused by electromagnetic induction, twist the measurement circuit wires at short, equal intervals.
  - Make sure to earth ground the protective ground terminal through minimum resistance.
  - When wiring input/output signal cables, observe the minimum bend radius of the cables. For the minimum bend radius, use the specifications indicated by the input signal cable manufacturer or six times the conductor diameter of the input/output signal cable, whichever is larger.
  - When using internal reference junction compensation on the thermocouple input, take measures to stabilize the temperature at the input terminal.
  - Always use the terminal cover.
  - Do not use thick wires which may cause large heat dissipation (we recommend a cross sectional area of $0.5 \, \text{mm}^2$ or less).
  - Make sure that the ambient temperature remains reasonably stable. Large temperature fluctuations can occur if a nearby fan turns on or off.

- Connecting the input wires in parallel with other devices can cause signal degradation, affecting all connected devices. If you need to make a parallel connection, then
  - Turn the burnout detection function off.
  - Ground the instruments to the same point.
  - Do not turn ON or OFF another instrument during operation. This can have adverse effects on the other instruments.
  - RTDs cannot be wired in parallel.

Wiring Procedure

A terminal cover is screwed in place on the I/O terminal block. A label indicating the terminal arrangement is affixed to the cover.

1. Turn off the GX/GP/GX60, and remove the terminal cover.
2. Connect the signal cables to the terminals.

\[
\begin{align*}
\text{Recommended torques for tightening the screws} \\
\text{Screw terminal (M3)} & \quad 0.5 \text{ to } 0.6 \, \text{N\,m} \\
\text{Clamp terminal} & \quad \begin{align*}
\text{GX90XA: } 0.4 \, \text{N\,m} \\
\text{GX90XD: } 0.5 \, \text{N\,m} \\
\text{GX90XP: } 0.5 \, \text{N\,m}
\end{align*}
\end{align*}
\]

3. Attach the terminal cover and fasten it with screws. The appropriate tightening torque for the screws is 0.6 N•m.

Inside dimension of M3 screw terminal block

\[
\begin{align*}
\text{Approx. } 6 \, (0.23) \, \text{mm} \\
\text{Unit: mm (approx. inch)}
\end{align*}
\]

Wiring Clamped Terminals

First, loosen the screw at the front using a flat-blade screwdriver. Insert the input signal wire into the slit on the left side of the terminal block, and fasten the screw at the front.

Note

With a clamp terminal, if you use a single wire whose diameter is 0.3 mm or less, you may not be able to clamp the wire securely to the terminal. Take measures to securely clamp the wire such as by folding the conductor section that will be connected to the clamp terminal in half.
Installation and Wiring

Wiring to a GX90XA Analog Input Module
Universal/Low withstand voltage relay/ Electromagnetic relay/Current (mA)/High withstand voltage type

Terminal Diagram
M3 screw terminal

Clamp terminal

Wiring Diagram
DC voltage input/DI (level) DI (contact)
TC input RTD input
DC current input (with an external shunt resistor) current input

Type Input type Wiring
-U2 DC voltage, thermocouple (TC), resistance temperature detector (RTD), DI (voltage, contact), and DC current (by adding an external shunt resistor) 1, 2, 3, 4, 5
-C1 DC current (mA) 6
-L1 DC voltage, thermocouple (TC), DI (voltage, contact), and DC current (by adding an external shunt resistor) 1, 2, 3, 5
-T1
-V1

Terminal Arrangement
M3 screw terminal

Clamp terminal

1 There are no symbol indications for the electromagnetic relay, current (mA), low withstand voltage relay or high withstand voltage type.

The RTD b terminal is connected internally.

High-speed universal

Terminal Diagram
M3 screw terminal

Clamp terminal

DC voltage input/DI (level) DI (contact)
TC input RTD input
DC current input (with an external shunt resistor)

* Be careful because the DI wiring is different between level and contact.
Terminal Arrangement

M3 screw terminal

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>301</td>
<td>/A</td>
<td>201</td>
<td>-/b</td>
<td>101</td>
<td>+/B</td>
</tr>
<tr>
<td>CH2</td>
<td>304</td>
<td>/A</td>
<td>204</td>
<td>-/b</td>
<td>104</td>
<td>+/B</td>
</tr>
<tr>
<td>CH3</td>
<td>307</td>
<td>/A</td>
<td>207</td>
<td>-/b</td>
<td>107</td>
<td>+/B</td>
</tr>
<tr>
<td>CH4</td>
<td>310</td>
<td>/A</td>
<td>210</td>
<td>-/b</td>
<td>110</td>
<td>+/B</td>
</tr>
</tbody>
</table>

Clamp terminal

<table>
<thead>
<tr>
<th>CH No.</th>
<th>Term. No.</th>
<th>Symbol</th>
<th>Term. No.</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>201</td>
<td>+/B</td>
<td>101</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>202</td>
<td>-/b</td>
<td>102</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>203</td>
<td>/A</td>
<td>103</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>204</td>
<td>Not Used</td>
<td>104</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH2</td>
<td>205</td>
<td>+/B</td>
<td>105</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>206</td>
<td>-/b</td>
<td>106</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>207</td>
<td>/A</td>
<td>107</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>208</td>
<td>Not Used</td>
<td>108</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH3</td>
<td>209</td>
<td>+/B</td>
<td>109</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>210</td>
<td>-/b</td>
<td>110</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>211</td>
<td>/A</td>
<td>111</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>212</td>
<td>Not Used</td>
<td>112</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH4</td>
<td>213</td>
<td>+/B</td>
<td>113</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>214</td>
<td>-/b</td>
<td>114</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>215</td>
<td>/A</td>
<td>115</td>
<td>Not Used</td>
</tr>
</tbody>
</table>

* Empty terminals may not be used.

4-wire RTD/resistance Terminal Diagram

M3 screw terminal

Wiring direction

Clamp terminal

Wiring direction

Wiring to a GX90XD Digital Input Module

Terminal Arrangement

M3 screw terminal

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>301</td>
<td>B</td>
<td>201</td>
<td>A</td>
<td>101</td>
<td>I</td>
</tr>
<tr>
<td>CH2</td>
<td>302</td>
<td>C</td>
<td>202</td>
<td>Not Used</td>
<td>102</td>
<td>C</td>
</tr>
<tr>
<td>CH3</td>
<td>303</td>
<td>B</td>
<td>203</td>
<td>A</td>
<td>103</td>
<td>I</td>
</tr>
<tr>
<td>CH4</td>
<td>304</td>
<td>B</td>
<td>204</td>
<td>A</td>
<td>104</td>
<td>I</td>
</tr>
<tr>
<td>CH5</td>
<td>305</td>
<td>C</td>
<td>205</td>
<td>Not Used</td>
<td>105</td>
<td>C</td>
</tr>
<tr>
<td>CH6</td>
<td>306</td>
<td>B</td>
<td>206</td>
<td>A</td>
<td>106</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>307</td>
<td>B</td>
<td>207</td>
<td>A</td>
<td>107</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>308</td>
<td>C</td>
<td>208</td>
<td>Not Used</td>
<td>108</td>
<td>C</td>
</tr>
<tr>
<td>CH1</td>
<td>309</td>
<td>B</td>
<td>209</td>
<td>A</td>
<td>109</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>310</td>
<td>Not Used</td>
<td>209</td>
<td>Not Used</td>
<td>110</td>
<td>Not Used</td>
</tr>
</tbody>
</table>

Clamp terminal

<table>
<thead>
<tr>
<th>CH No.</th>
<th>Term. No.</th>
<th>Symbol</th>
<th>Term. No.</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>201</td>
<td>I</td>
<td>101</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>202</td>
<td>A</td>
<td>102</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>203</td>
<td>B</td>
<td>103</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>204</td>
<td>C</td>
<td>104</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH2</td>
<td>205</td>
<td>Not Used</td>
<td>105</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>206</td>
<td>A</td>
<td>106</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>207</td>
<td>B</td>
<td>107</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>208</td>
<td>C</td>
<td>108</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH3</td>
<td>209</td>
<td>Not Used</td>
<td>109</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>210</td>
<td>A</td>
<td>110</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>211</td>
<td>B</td>
<td>111</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>212</td>
<td>C</td>
<td>112</td>
<td>Not Used</td>
</tr>
<tr>
<td>CH4</td>
<td>213</td>
<td>A</td>
<td>113</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>214</td>
<td>B</td>
<td>114</td>
<td>Not Used</td>
</tr>
<tr>
<td></td>
<td>215</td>
<td>C</td>
<td>115</td>
<td>Not Used</td>
</tr>
</tbody>
</table>

* Empty terminals may not be used.

Wiring direction
Wiring to a GX90YD Digital Output Module

**Terminal Diagram**

**Terminal Arrangement**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DO4</td>
<td>21</td>
<td>NC</td>
<td>DO1</td>
<td>11</td>
<td>NC</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>COM</td>
<td></td>
<td>12</td>
<td>COM</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>NO</td>
<td></td>
<td>13</td>
<td>NO</td>
</tr>
<tr>
<td>DO5</td>
<td>24</td>
<td>NC</td>
<td>DO2</td>
<td>14</td>
<td>NC</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>COM</td>
<td></td>
<td>15</td>
<td>COM</td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>NO</td>
<td></td>
<td>16</td>
<td>NO</td>
</tr>
<tr>
<td>DO6</td>
<td>27</td>
<td>NC</td>
<td>DO3</td>
<td>17</td>
<td>NC</td>
</tr>
<tr>
<td></td>
<td>28</td>
<td>COM</td>
<td></td>
<td>18</td>
<td>COM</td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>NO</td>
<td></td>
<td>19</td>
<td>NO</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>-</td>
<td></td>
<td>20</td>
<td>-</td>
</tr>
</tbody>
</table>

**Internal circuit**

- Input type: Photocoupler isolation
- DI1 to DI8: COM1
- DI9 to DI16: COM2
- Shared common (COM)
- Allowable input voltage range: 0 to 10V

**Note:** Do not apply voltage outside the allowable input voltage range across input terminals. Doing so can cause a malfunction.

---

Wiring to a GX90WD Digital Input/Output Module

**Terminal Diagram**

**Terminal Arrangement**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DI1</td>
<td>301</td>
<td>DI3</td>
<td>201</td>
<td>DI2</td>
<td>101</td>
<td>DI1</td>
</tr>
<tr>
<td></td>
<td>302</td>
<td>DI6</td>
<td>202</td>
<td>DI5</td>
<td>102</td>
<td>DI4</td>
</tr>
<tr>
<td></td>
<td>303</td>
<td>DICOM</td>
<td>203</td>
<td>DI8</td>
<td>103</td>
<td>DI7</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>-</td>
<td>304</td>
<td>-</td>
<td>204</td>
<td>-</td>
</tr>
<tr>
<td>DO1</td>
<td>305</td>
<td>DO1NO</td>
<td>205</td>
<td>DO1COM</td>
<td>105</td>
<td>DO1NC</td>
</tr>
<tr>
<td>DO2</td>
<td>306</td>
<td>DO2NO</td>
<td>206</td>
<td>DO2COM</td>
<td>106</td>
<td>DO2NC</td>
</tr>
<tr>
<td>DO3</td>
<td>307</td>
<td>DO3NO</td>
<td>207</td>
<td>DO3COM</td>
<td>107</td>
<td>DO3NC</td>
</tr>
<tr>
<td>DO4</td>
<td>308</td>
<td>DO4NO</td>
<td>208</td>
<td>DO4COM</td>
<td>108</td>
<td>DO4NC</td>
</tr>
<tr>
<td>DO5</td>
<td>309</td>
<td>DO5NO</td>
<td>209</td>
<td>DO5COM</td>
<td>109</td>
<td>DO5NC</td>
</tr>
<tr>
<td>DO6</td>
<td>310</td>
<td>DO6NO</td>
<td>210</td>
<td>DO6COM</td>
<td>110</td>
<td>DO6NC</td>
</tr>
</tbody>
</table>

**Internal circuit**

- Input type: Photocoupler isolation
- DICOM
- Allowable input voltage range: 0 to 10V

**Note:** Do not apply voltage outside the allowable input voltage range across input terminals. Doing so can cause a malfunction.

---

Wiring to a GX90XP Pulse Input Module

**Terminal Diagram**

**Terminal Arrangement**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>11</td>
<td>+</td>
<td>CH1</td>
<td>+</td>
<td>(11)</td>
<td>+</td>
</tr>
<tr>
<td>CH1</td>
<td>12</td>
<td>-</td>
<td>CH1</td>
<td>-</td>
<td>(12)</td>
<td>-</td>
</tr>
<tr>
<td>CH5</td>
<td>19</td>
<td>+</td>
<td>CH5</td>
<td>+</td>
<td>(19)</td>
<td>+</td>
</tr>
<tr>
<td>CH5</td>
<td>20</td>
<td>-</td>
<td>CH5</td>
<td>-</td>
<td>(20)</td>
<td>-</td>
</tr>
<tr>
<td>CH6</td>
<td>(11)</td>
<td>+</td>
<td>CH1</td>
<td>(11)</td>
<td>+</td>
<td>CH1</td>
</tr>
<tr>
<td>CH6</td>
<td>(22)</td>
<td>-</td>
<td>CH1</td>
<td>(22)</td>
<td>-</td>
<td>CH1</td>
</tr>
<tr>
<td>CH10</td>
<td>(19)</td>
<td>+</td>
<td>CH5</td>
<td>(19)</td>
<td>+</td>
<td>CH5</td>
</tr>
<tr>
<td>CH10</td>
<td>(30)</td>
<td>-</td>
<td>CH5</td>
<td>(30)</td>
<td>-</td>
<td>CH5</td>
</tr>
</tbody>
</table>

**Internal circuit**

- Input type: Photocoupler isolation
- Shared common (DICOM)
- Allowable input voltage range: 0 to 10V

**Note:** Do not apply voltage outside the allowable input voltage range across input terminals. Doing so can cause a malfunction.
## Wiring to a GX90UT PID Control Module

**Terminal Diagram**

**M3 screw terminal**

<table>
<thead>
<tr>
<th>Term. No.</th>
<th>Symbol</th>
<th>Term. No.</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>301</td>
<td>DI3</td>
<td>201</td>
<td>DI2</td>
</tr>
<tr>
<td>302</td>
<td>DI6</td>
<td>202</td>
<td>DI5</td>
</tr>
<tr>
<td>303</td>
<td>Dicom</td>
<td>203</td>
<td>DI8</td>
</tr>
<tr>
<td>304</td>
<td>DO3</td>
<td>204</td>
<td>DO2</td>
</tr>
<tr>
<td>305</td>
<td>DO6</td>
<td>205</td>
<td>DO5</td>
</tr>
<tr>
<td>306</td>
<td>Do-com</td>
<td>206</td>
<td>DO8</td>
</tr>
<tr>
<td>307</td>
<td>AI1/(A)</td>
<td>207</td>
<td>AI1(-)</td>
</tr>
<tr>
<td>308</td>
<td>AI2/(A)</td>
<td>208</td>
<td>AI2(-)</td>
</tr>
<tr>
<td>309</td>
<td>Not Used</td>
<td>209</td>
<td>AO1(-)</td>
</tr>
<tr>
<td>310</td>
<td>Not Used</td>
<td>210</td>
<td>AO1(+)</td>
</tr>
</tbody>
</table>

* Empty terminals may not be used

---

### Wiring Direction

**DI**

- **DO**

**AI**

- **AO**

---

### Installation and Wiring

#### Terminal Arrangement

<table>
<thead>
<tr>
<th>Term. No.</th>
<th>Symbol</th>
<th>Term. No.</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>CH6</td>
<td>11</td>
<td>CH1</td>
</tr>
<tr>
<td>22</td>
<td>-</td>
<td>12</td>
<td>-</td>
</tr>
<tr>
<td>23</td>
<td>CH7</td>
<td>13</td>
<td>CH2</td>
</tr>
<tr>
<td>24</td>
<td>-</td>
<td>14</td>
<td>-</td>
</tr>
<tr>
<td>25</td>
<td>CH8</td>
<td>15</td>
<td>CH3</td>
</tr>
<tr>
<td>26</td>
<td>-</td>
<td>16</td>
<td>-</td>
</tr>
<tr>
<td>27</td>
<td>CH9</td>
<td>17</td>
<td>CH4</td>
</tr>
<tr>
<td>28</td>
<td>-</td>
<td>18</td>
<td>-</td>
</tr>
<tr>
<td>29</td>
<td>CH10</td>
<td>19</td>
<td>CH5</td>
</tr>
<tr>
<td>30</td>
<td>-</td>
<td>20</td>
<td>-</td>
</tr>
</tbody>
</table>

Negative terminal (common) potential shared

---

### Internal Circuit

Input type:
- Photocoupler isolation
- Negative terminal (common) potential shared
- Allowable input voltage: ±10V

---

### Analog Input

- **DC voltage input/DI (level)**
- **DI (contact)**

---

### TC input

- **RTD input**

---

### DC current input

- **with an external shunt resistor**

---

### Analog Output

- **DC current output, voltage pulse, 15 V DC loop power supply**

---

**Terminal Diagram**

- **M3 screw terminal**

---

**Wiring direction**
Connecting to the FAIL Output/Status Output (/FL option)

Recommended torque for tightening the screws: 0.5N•m

Connecting to the Serial Communication Interface (/C2 option)

Connecting to the RS-422/485 Connector (/C3 option)

Connecting to the VGA Connector (/D5 option)

Connecting to a Monitor

Note

Connecting to the USB Port (/UH option)

A USB2.0 compliant port (see “Component Names”)
Connecting to the Ethernet Port
Checking the Connection and Communication Status
You can use the indicators that are located above the Ethernet port to check the connection status of the Ethernet interface.

Indicators
- Yellow-green: Connection status of the Ethernet Interface
- Orange: Receiving data

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Connection Status of the Ethernet Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lit (yellow-green)</td>
<td>The Ethernet link is established.</td>
</tr>
<tr>
<td>Off (yellow-green)</td>
<td>The Ethernet link is not established.</td>
</tr>
<tr>
<td>Blinking (yellow-green)</td>
<td>Receiving data</td>
</tr>
<tr>
<td>Lit (orange)</td>
<td>Connected at 100 Mbps</td>
</tr>
<tr>
<td>Off (orange)</td>
<td>Connected at 10 Mbps</td>
</tr>
</tbody>
</table>

Wiring the Power Supply
Use a power supply that meets the following conditions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Condition (Not /P1)</th>
<th>Condition (/P1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated supply voltage</td>
<td>100 to 240 VAC</td>
<td>24 VDC/AC</td>
</tr>
<tr>
<td>Allowable power supply voltage range</td>
<td>GX/GP: 90 to 132 VAC, 180 to 264 VAC</td>
<td>21.6 V to 26.4 VDC/AC</td>
</tr>
<tr>
<td></td>
<td>GX60: 90 to 132 VAC, 180 to 240 VAC</td>
<td></td>
</tr>
<tr>
<td>Rated power supply frequency</td>
<td>50/60 Hz</td>
<td>50/60 Hz (for AC)</td>
</tr>
<tr>
<td>Permitted power supply frequency range</td>
<td>50/60 Hz ± 2%</td>
<td>50/60 Hz ± 2% (for AC)</td>
</tr>
<tr>
<td>Maximum power consumption 100 VAC (/P1: 24 VDC)</td>
<td>GX10/GP10: 48 VA</td>
<td>GX10: 24 VA</td>
</tr>
<tr>
<td></td>
<td>GX20/GP20: 90 VA</td>
<td>GX20: 48 VA</td>
</tr>
<tr>
<td></td>
<td>GX60: 40 VA</td>
<td></td>
</tr>
<tr>
<td>Maximum power consumption 240 VAC (/P1: 24 VAC)</td>
<td>GX10/GP10: 60 VA</td>
<td>GX10: 42 VA</td>
</tr>
<tr>
<td></td>
<td>GX20/GP20: 110 VA</td>
<td>GX20: 76 VA</td>
</tr>
<tr>
<td></td>
<td>GX60: 55 VA</td>
<td></td>
</tr>
</tbody>
</table>

**Note**
Do not use a supply voltage of 132 to 180 VAC, as this may have adverse effects on the measurement accuracy.

GP10 Power Supply Suffix Code: 2

<table>
<thead>
<tr>
<th>Item</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated supply voltage</td>
<td>12 VDC</td>
</tr>
<tr>
<td>Allowable power supply voltage range</td>
<td>10 V to 20 VDC</td>
</tr>
<tr>
<td>Maximum power consumption</td>
<td>26 VA</td>
</tr>
</tbody>
</table>

Precautions to Be Taken When Wiring the Power Supply (GX10/GX20/GX60)
Make sure to follow the warnings below when wiring the power supply. Failure to do so may cause electric shock or damage to the instrument.

**WARNING**
- To prevent electric shock, ensure that the power supply is turned off.
- To prevent fire, use 600 V PVC insulated wires (AWG20 to AWG16; JISC3307) or wires or cables with equivalent or better performance.
- Make sure to earth ground the protective ground terminal through minimum resistance before you turn on the power.
- Use crimp-on lugs (designed for 4 mm screws) with insulation sleeves to connect both the power cord and the protective ground.
- To prevent electric shock, be sure to close the transparent cover for the power supply wires.
- Provide a power switch (double-pole type) on the power supply line to separate the GX/GP from the main power supply. Use labels to indicate that this switch is for cutting off the power supply to the GX/GP and to indicate ON and OFF.

**Switch specifications**
- Steady-state: 1 A or higher (Not /P1), current rating: 3 A or higher (/P1)
- Inrush: 60 A or higher (Not /P1), current rating: 70 A or higher (/P1)
- Must comply with IEC60947-1 and IEC60947-3.
- Do not add a switch or fuse to the ground line.

Wiring Procedure (GX10/GX20/GX60)
1. Turn off the GX power supply, and then remove the transparent power supply terminal cover.
2. Connect the power cord and the protective ground cord to the power supply terminal. Use ring-torque crimp-on lugs (for M4 screws) with insulation sleeves. The appropriate tightening torque for the screws is 1.4 to 1.5 N•m.

![Protective ground](image)

3. Attach the transparent power supply terminal cover, and fasten it with screws.
Precautions to Be Taken When Connecting the Power Supply (GP10/GP20/GX60)
Make sure to follow the warnings below when connecting the power supply. Failure to do so may cause electric shock or damage to the instrument.

- Before connecting the power cord, ensure that the source voltage matches the rated supply voltage of the instrument and that it is within the maximum rated voltage range of the provided power cord.
- Connect the power cord after checking that the power switch of the instrument is turned OFF.
- To prevent electric shock and fire, be sure to use a power cord purchased from Yokogawa Electric Corporation.
- Make sure to connect protective earth grounding to prevent electric shock. Insert the power cord into a grounded three-prong outlet.
- Do not use an extension cord without protective earth ground. If you do, the instrument will not be grounded.

Connection Procedure
1. Check that the GP’s power switch is off.
2. Connect the supplied power cord plug to the power inlet on the rear panel of the GP or front panel of the GX60.
3. Ensure that the source voltage is within the maximum rated voltage range of the provided power cord. Then, connect the other end of the cord to the outlet. Use a grounded three-prong outlet.

Precautions to Be Taken When Connecting the Power Supply (GP10 Power supply Suffix Code: 2)
Make sure to follow the warnings below when connecting the power supply. Failure to do so may cause damage to the instrument.

- Wire the power cable to the power supply terminal, making sure that the polarity is correct.
- Connect the power cables after checking that the power switch of the instrument is turned OFF.
- Using other wires may cause abnormal heating or fire.

Wiring Procedure (GP10 Power supply Suffix Code: 2)
1. Turn off the GP power supply, and then remove the transparent power supply terminal cover.
2. Wire the power cable to the power supply terminal, making sure that the polarity is correct. Use ring-tongue crimp-on lugs (for M4 screws) with insulation sleeves. The appropriate tightening torque for the screws is 1.4 to 1.5 N•m. Use 600 V PVC insulated wires (AWG20 to AWG16; JISC3307) or wires or cables with equivalent or better performance.
3. Attach the transparent power supply terminal cover, and fasten it with screws.
This section explains the details indicated as “Basic Operation” in the operating procedure on pages 22 and 23.

### Basic Operation

#### Turning the Power On and Off

**WARNING**

To make panel door lock for GX10/GX20 or install the GP/GX60 systems in a panel with a door or in a location where operator or any third person can not operate the power switch carelessly. When the power switch of GX/GP systems under operation (control in progress) be turned on or off carelessly, it may result the system down or injury. Be careful to operate the power switch on or off. Careless operations can be avoided by applying the slide lock.

**CAUTION**

- If nothing appears on the display even when you turn on the power switch, turn off the power switch, and check the wiring and supply voltage. If, after checking these items, the GX/GP still fails to start when you turn on the power switch, it may be malfunctioning. Contact your nearest Yokogawa dealer for repairs.
- If an error message appears on the screen, take measures according to the information in chapter 5, “Troubleshooting” in the GX/GP User’s Manual.
- After you turn on the power switch, allow the GX/GP to warm up for at least 30 minutes before starting a measurement.

#### Turning the Power On

**CAUTION**

Check the following points before turning on the power switch.
- The power cord or wires are connected properly to the GX/GP and GX60.
- The GX/GP is connected to the correct power supply.

If the input wiring is connected in parallel with another instrument, do not turn on or off the GX/GP/GX60 or other instrument during operation. If you do, measured values may be affected.

**GX/GP**

1. Open the front door.
2. Turn on the power switch.
   A self-test takes place for a few seconds, and then the operation screen appears.
3. Close the front door.

#### Turning the Power Off

**CAUTION**

Check the following points before turning off the power switch.
- The external storage medium is not being accessed (the yellow-green LED is not blinking).

**GX/GP**

1. Open the front door.
2. Turn off the power switch.
3. Close the front door.

**GX60**

1. Turn off the power switch.
Setting and Removing SD Memory Cards

Setting a SD Memory Card
1. Open the front door.
2. Insert an SD memory card into the card slot.

Removing the SD Memory Card
1. Press MENU.
2. Tap the media eject icon.
3. On the screen for selecting the type of media, tap SD.
4. Remove the SD memory card.

Operation complete

Viewing the Operation Screen (Trend)

Status display section
- Shows the display name, date/time, data recording, alarm icons, etc.

Numeric display section
- Shows measured data and function setup screens

Waveform display

Data display section
- Shows the progress using a green bar graph. The frame indicates the saving interval (display data) or data length (event data).

Display name or group name
- When using the batch function
- When using the login function
- When using the login and batch functions

Recording status icon
- Recording in progress
- Recording stopped

Data type
- DISP: Display data
- EVENT: Event data

Recording progress
- Internal memory error

Scale
Displaying the Menu Screen

To change the display between various setup screens and operation screens, display the menu screen.

1. Press **MENU**.
   The menu screen appears.

Setting the Date and Time*

* If you need to set the time zone or DST (Daylight Saving Time) or both, do so before setting the date and time.

**Path**

**MENU key > Browse tab > Setting > System settings > Time basic settings**

Set the date using the calendar and the time.

**Path**

**MENU key > Universal tab > Date/Time settings**

1. Tap the **Date tab**.
2. Set the month and day with the switch icons.
Basic Operation

3 Tap the Time tab.
4 Enter the time using the keyboard, and tap OK. The time is set.

Operation complete

Configuring the Inputs

For channel 1 (0001) of slot 0, set thermocouple type T, 0 to 200°C.

Path MENU key > Browse tab > Setting > Setting menu > Al channel settings > Range

1 Tap First-CH > 0001.
2 Check that Last-CH is 0001.
3 Tap Type > TC.
4 Tap Range > T.
5 Tap Span Lower, and enter 0.0.
6 Tap Span Upper, and enter 200.0.
7 Tap Save.

Operation complete

Starting Measurement and Recording

1 Press MENU. The menu screen appears.
2 Tap the Recording icon. The record start screen appears.
3 Tap Record. Recording starts. The recording status icon in the status display section changes to recording in progress.

Operation complete

You can also start recording with the START/STOP key. You can stop recording in the same way that you start recording.

Switching between Operation Screens

1 Press MENU. The menu screen appears.
2 Tap the Browse tab.
3 Tap the icon of the display that you want to change to.

Operation complete
**Saving Data to USB Memory**

1. Set the USB memory. The Media operation screen appears.
2. Tap the Memory save Data save icon. The Memory summary / Save screen appears.
3. Press MENU. The menu screen appears.
4. Tap the Context tab. Each data save icon appears.
5. Tap data save icon to save. The data save screen appears.
6. Select the USB, and tap OK. The data is save to USB memory.

---

**Switching the Quick Settings (GP only)**

A minimal setup menu for data collection is displayed.

1. Tap the Quick setting tab. Setting menu of the quick setting is displayed.

---

*Operation complete*
Advanced Operation (Various settings and operation)

Setting Measurement and Recording Conditions

Configuring the type of data to record to display data, the scan interval to 2 s, and the trend interval to 1 min.

Setting the Type of Data to Record

Path: MENU key > Browse tab > Setting > Setting menu > Recording Settings > Basic settings

1. Tap File type > Display.
2. Tap Save.

You can set the file type to record only the data that suits your purpose. For example, you can record detailed data or record data only when alarms occur. For details, see the User’s Manual (IM 04L51B01-01EN).

Setting the Scan Interval

Path: MENU key > Browse tab > Setting > Setting menu > Measurement settings > Scan interval

1. Tap Scan interval > 2s.
2. Tap Save.

Operation complete

Setting the Trend Interval

Path: MENU key > Browse tab > Setting > Setting menu > Display settings > Trend interval

1. Tap Trend interval [div] > 1 min.
2. Tap Save.

Operation complete

Setting Alarms

On channel 1 of slot 0, set the high limit alarm at the alarm value of 150°C.

Path: MENU key > Browse tab > Setting > Setting menu > AI channel settings > Alarm

1. Tap First-CH > 0001.
2. Check that Last-CH is 0001.
3. Tap Level1 > On.
4. Tap Type > H.
5. Tap Value, and enter 150.0.
6. Tap Save.

Operation complete

This section explains how to change various settings. Before you change settings, stop recording and computation.
### Using the Scaling Function
(Measuring a flow meter)

On channel 1 of slot 1 (0101), measure the input signal ranging from 1 to 5 VDC as 0.0 to 100.0 m³/h.

1. Tap **Output type** > Relay.
2. Tap the **Output No.**, and enter 0101.

#### Path
MENU key > Browse tab > Setting > Setting menu > AI channel settings > Range

1. Tap **First-CH** > 0101.
2. Check that **Last-CH** is 0101.
3. Tap **Type** > Alarm.
4. Tap **Save**.

---

### Alarm DO output

Alarms are transmitted via DO output to DO channel 1 of slot 1. (A DO output module is required.) Configure the following settings in the alarm settings (see “Setting Alarms”).

1. Tap **Output type** > Relay.
2. Tap the **Output No.**, and enter 0101.

#### Path
MENU key > Browse tab > Setting > Setting menu > DO channel settings > Range

1. Tap **First-CH** > 0101.
2. Check that **Last-CH** is 0101.
3. Tap **Type** > GS.
4. Tap **Save**.

---

**Operation complete**
Using the Scaling Function (Measuring a temperature)

On channel 1 of slot 0 (0001), measure the input signal ranging from 0 to 5 VDC as 0.0 to 600.0 °C.

Path

1. Tap First-CH > 0001.
2. Check that Last-CH is 0001.
3. Tap Type > Volt.
4. Tap Range > 6V.
5. Tap Span Lower, and enter 0.000.
6. Tap Span Upper, and enter 5.000.
7. Tap Calculation > Linear scaling.
8. Drag the screen up. Show the setting parameters off the screen at the bottom.
9. Tap Decimal place > 1.
10. Tap Scale Lower, and enter 0.0.
11. Tap Scale Upper, and enter 600.0.
12. Tap Unit > °C, and enter °C.
13. Tap Save.

Registering and Deleting Favorite Screens

You can register displays that you use frequently as favorite screens and display them with easy operation. You can register up to 20 displays.

Registering a Favorite Screen

1. Show the display that you want to register as a favorite screen.
2. Press MENU. The menu screen appears.
3. Tap Add favorite. A confirmation screen appears.
4. Tap Favorite name, and enter the name.
5. Tap OK. The display is registered.
6. Tap the Close icon. The screen closes.

Deleting a Favorite Screen

1. Press MENU.
2. Tap Universal tab > Remove favorite.
3. Select the screen to delete, and tap OK.
4. Tap the Close icon. The screen closes.
This section explains the measurement mode, which needs to be set properly according to the measurement conditions.

### Setting the Measurement Mode

The measurement mode determines how the entire GX/GP system operates. The GX/GP measurement characteristics change depending on the measurement mode. The measurement mode must be set before reconfiguration and before specifying various settings. By factory default, the measurement mode is set to Normal. When performing high-speed or dual interval measurement according to measurement conditions, you need to set the measurement mode to High speed or Dual interval.

1. Press MENU.
2. Tap the **Browse** tab.
3. Tap **Initialize Calibration**.
4. Tap **Measurement mode**.
5. Setting the Measurement Mode.
6. Tap **Execute**.
   - A confirmation screen is displayed.
7. Tap **OK**

---

**Note**

- When the measurement mode is changed, the system restarts, and the following data is initialized. Set the measurement mode before reconfiguration and before specifying various settings.
- **Data subject to initialization**
  - All internal data
  - All setting parameters including security settings but excluding communication settings
  - System configuration data

- You cannot set the measurement mode when recording, computation, or control execution is in progress.
- The measurement mode is not initialized during initialization.
- If the advanced security function (IAS) or multi-batch function (BT) is enabled (On), the measurement mode is fixed to Normal. When changing the measurement mode, disable the functions beforehand.

### Limitations

Depending on the measurement mode, there is a limit to the number of measurement channels, the number of recording channels, and the supported modules. For the specific limitations, see the limitations provided in the following general specifications.

- **GX/10/GX20 Paperless Recorder (panel mount type)**
  - General Specifications GS 04L51B01-01EN
- **GP10/GP20 Paperless Recorder (portable type)**
  - General Specifications GS 04L52B01-01EN
Reconfiguring the GX/GP (Module identification)

**Reconfiguring the GX/GP**
When you reconfigure the GX/GP and the GX60, the installed I/O modules are detected, and the settings are changed accordingly. Reconfiguration is necessary in the following situations:
- If you specify modules separately
- If you change the modules (change to different modules)
- If you add or remove modules
- If you connect the GX60
- When the measurement mode is changed
- When the advanced security function on/off state is changed

If you purchased a model with preinstalled modules (/U[ ][]0 or /CR[ ][] option), you can start using the GX/GP right away without any reconfiguration. However, if you connect the GX60, change modules, add modules, or delete modules, you will need to reconfigure.

**Note**
You cannot reconfigure GX/GP while recording start, math start, controlled.

1. Press MENU.
2. Tap the Browse tab.
3. Tap Initialize Calibration.
4. Tap Reconfiguration.
5. Tap Execute.
   - The system information appears.

6. Tap Reconfigure.
7. Tap OK.

**Note**
Do not carry out the following operations while the GX/GP is reconfiguring.
- Turn the power off and on
- Insert or remove modules

This procedure is not necessary if you purchased an I/O module preinstalled model and do not need to change the configuration.

---

Initializing the GX/GP (Initializing all settings)

Initialize the GX/GP after reconfiguring the GX/GP when channels are not assigned to display groups. Channels are automatically assigned during initialization. For details, see the User’s Manual (IM 04L51B01-01EN).

**Note**
- This procedure is not necessary if you purchased an I/O module preinstalled model and do not need to change the configuration.
- If you initialize, setting parameters are reset to their factory defaults. We recommend that you back up setting parameters before initialization.

1. Press MENU.
2. Tap the Browse tab.
3. Tap Initialize Calibration > Initialize > Settings/Inter data.
4. Tap Initialize all > On.
5. Tap Execute.
   - A confirmation screen is displayed.
6. Tap OK.
   - The settings are initialized.

---

This section explains what you need to do when you change the module configuration (by installing or removing modules).
This section explains how to back up setting parameters. Before you change the module configuration or settings, we recommend that you back up the setting parameters.

### Saving and Loading Setting Parameters

#### Saving Setting Parameters

Save setting parameters to the SD memory card with the file name “SF1.”

**Path**

MENU key > Browse tab > Save load > Menu Save settings > Setting parameters

1. Tap Media kind > SD.
2. Tap File name, and enter SF1.
3. Tap Execute.
4. Tap Exit.

#### Loading Setup Parameters

Load the setup parameter file “SF1.GNL” from the SD memory card.

**Path**

MENU key > Browse tab > Save load > Menu Load settings > Setting parameters

1. Tap Media kind > SD.
2. Tap File name > SF1.GNL.
3. Tap Execute.
4. Tap Exit.
You can open the Web application simply by starting a Web browser (IE11, Chrome 7x), and specifying the GX/GP IP address. You do not have to install any software. You can do the following on the Web application.

- Operate the GX/GP
- Monitor data
- Changing setting parameters

For details on configuring the environment settings to connect the GX/GP to an Ethernet network and how to use the software, see the User’s Manual (IM 04L51B01-01EN).

### Starting the Web Application

1. Start the Web browser.

2. In the Address box, enter “http://” followed by the GX/GP IP address. If DNS is available, you can specify the host name in place of the IP address.

   Example: When the IP address is “192.168.1.1,” enter http://192.168.1.1 in the Address box.

   The Web application starts, and the screen appears.

### Closing the Web Application

When close the Web browser, the Web application also closes.
Application Software

The following software applications are available for the GX/GP.
- SMARTDAC+ STANDARD Universal Viewer
- SMARTDAC+ STANDARD Hardware Configurator (Included program pattern setting)

You can use SMARTDAC+ STANDARD Universal Viewer to display on screen and print the following types of data that is generated by recorders.
- Display data files
- Event data files
- Report data files (including hourly, daily, monthly, batch, and daily-custom, and free reports)
- Manual sampled data files

Two different recording data files can be displayed superimposed.

You can attach also convert measured data to ASCII or Excel formats.

You can use SMARTDAC+ STANDARD Hardware Configurator to create and edit setup data for the GX/GP recorder.

In addition, program patterns can be created and sent to the GX/GP.

You can download the latest software and labels from the following URL.
URL: www.smartdacplus.com/software/en/

You can download the product user’s manuals from the following URL.

PC System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>Home Premium SP1 (32- or 64-bit edition)</td>
</tr>
<tr>
<td></td>
<td>Professional SP1 (32- or 64-bit edition)</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>Update</td>
</tr>
<tr>
<td></td>
<td>Pro Update</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Home (32- or 64-bit edition)</td>
</tr>
<tr>
<td></td>
<td>Pro (32- or 64-bit edition)</td>
</tr>
</tbody>
</table>

**CPU and main memory**

<table>
<thead>
<tr>
<th>OS</th>
<th>CPU and main memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 processor. At least 2 GB of memory.</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>64-bit edition: Intel Pentium 4, 3 GHz or faster x64 processor. At least 2 GB of memory.</td>
</tr>
<tr>
<td>Windows 10</td>
<td>64-bit edition: Intel Pentium 4, 3 GHz or faster x64 processor. At least 2 GB of memory.</td>
</tr>
</tbody>
</table>

**Web Browser**

<table>
<thead>
<tr>
<th>Compatible Browser</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Internet Explorer</td>
<td>11</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>7x</td>
</tr>
</tbody>
</table>

**Hard disk**

Free space of at least 100 MB (depending on the amount of data, you may need more memory).

**Display**

A video card that is recommended for the OS and a display that is supported by the OS, has a resolution of 1024×768 or higher, and that can show 65,536 colors (16-bit, high color) or more.

**Other Operating Conditions**

To view the user’s manuals, you need to use Adobe Reader 7 or later by Adobe Systems (the latest version recommended).

**Installation**

To install Universal Viewer or Hardware Configurator, download the installer from the Yokogawa website.

1. Turn on the PC, and start Windows.
   Log onto Windows as an administrator.

2. Double click the installer (**.exe**).
   The installer starts. Follow the instructions on the screen to install the software.

**Note**

- Close all other software applications before installing this software.
- To reinstall the software, uninstall the current software first.

**Hardware Configurator**

- The “Countries/regions except Japan” selection dialog box appears during installation. Select the country that you will use the software in.
- The HTTP port for using the Web browser is set to 34443. If this port is already in use by another application, you will not be able to start Hardware Configurator even if you install it. In such a case, perform the corrective action on section 1.4 in SMARTDAC+ STANDARD Hardware Configurator User’s Manual (IM 04L61B01-02EN).
About the User’s Manuals

The user’s manual is installed with the software. To view the manual, on the Help menu, click Instruction Manual. You can also access it from Start > All Programs. Use Adobe Reader 7.0 or later to view the manual. The software and manual are installed for the following languages.

<table>
<thead>
<tr>
<th>Language</th>
<th>Software</th>
<th>User’s manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japanese</td>
<td>Japanese</td>
<td>Japanese</td>
</tr>
<tr>
<td>English</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Chinese</td>
<td>Chinese</td>
<td>Chinese</td>
</tr>
<tr>
<td>French</td>
<td>French</td>
<td>English</td>
</tr>
<tr>
<td>German</td>
<td>German</td>
<td></td>
</tr>
<tr>
<td>Russian</td>
<td>Russian</td>
<td></td>
</tr>
<tr>
<td>Korean</td>
<td>Korean</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country Selected at Installation</th>
<th>Software</th>
<th>User’s manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japanese</td>
<td>Display language selectable: Japanese/English/ German/French/ Russian/Chinese/ Korean</td>
<td>Japanese, English, Chinese</td>
</tr>
<tr>
<td>Regions except Japan</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Starting and Closing Universal Viewer

Starting Universal Viewer

1. From the Start menu, click All Programs - SMARTDAC+ STANDARD - Viewer. Universal Viewer starts.

Closing Universal Viewer

1. On the File menu, click Exit. Or, click the × button.

Specifying a File Name and Opening the Data File

1. On the File menu, click Open. Or, click Open on the toolbar. The Open dialog box appears.

2. Select the data file you want to open, and click Open. Or, double-click the file. The data appears in the window.

Starting and Closing Hardware Configurator

Starting Hardware Configurator

1. From the Start menu, select All Programs - SMARTDAC+ STANDARD - Hardware Configurator. The first time Hardware Configurator starts after installation, the Windows Security Alert dialog box appears. Click Unblock. Hardware Configurator starts, and the following window appears.

Note

- Hardware Configurator will not start if Internet Explorer is not installed.
- The default settings are the system configuration of the GX10.

Closing Hardware Configurator

Close Internet Explorer.

1. Click the Close button; or on the File menu, click Exit.

Note

If you change the setup data, the changes are stored and will appear the next time you start the software.
### Setup Menu Map

Depending on setting parameter values, some items may be hidden. For details, see the User's Manual (IM 04L51B01-01EN).

#### AI channel settings, AI (mA) channel settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Range</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Span Lower</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Span Upper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Calculation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Reference channel</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Decimal place</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scale Lower</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scale Upper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Low-cut</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Low-cut value</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Low-cut output</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Moving average</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Count</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>First-order lag filter</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Filter coefficient</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>RJC</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Burnout set</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bias</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>First-CH</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last-CH</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Level 1</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Hysteresis</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Output type</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Output No.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Level 2</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Level 3</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Level 4</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm delay</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Hour</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Minute</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Second</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Display settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tag</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Characters No.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Zone Lower</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Zone Upper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Division</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bar graph</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Base position</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Partial</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>On/Off</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Expand</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Boundary</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color scale band</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Band area</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Display position Lower</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Display position Upper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm point mark</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Indicate on Scale</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mark kind</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm 1 color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm 2 color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm 3 color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Alarm 4 color</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Display characters of each value</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Calibration correction

<table>
<thead>
<tr>
<th>Parameter</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Burnout set</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bias</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>First-CH</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last-CH</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Number of set points</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Linearizer input</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Linearizer output</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Execution of input measurement</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note
- Depending on setting parameter values, some items may be hidden. For details, see the User's Manual (IM 04L51B01-01EN).
**Setup Menu Map**

Setting when the mode is set to Correction Coefficient on a module with an \(/AH\) option

1. Uncorrected value
2. Instrument correction factor
3. Sensor correction factor
4. Execution of input measurement

**DI channel settings**

<table>
<thead>
<tr>
<th>Range</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference channel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal place</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Alarm**

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>Type</td>
<td>Value</td>
<td>Hysteresis</td>
<td>Logging</td>
<td>Output type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Output No.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Level 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On/Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Level 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On/Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Level 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>On/Off</td>
</tr>
<tr>
<td>Alarm delay</td>
<td>Hour</td>
<td>Minute</td>
<td>Second</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Display settings**

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Tag</th>
<th>Characters</th>
<th>No.</th>
<th>Color</th>
<th>Color</th>
<th>Zone</th>
<th>Lower</th>
<th>Upper</th>
<th>Scale</th>
<th>Position</th>
<th>Division*</th>
<th>Bar graph</th>
<th>Base position</th>
<th>Division*</th>
<th>Alarm point mark</th>
<th>Indicate on Scale</th>
<th>Mark kind</th>
<th>Alarm 1 color</th>
<th>Alarm 2 color</th>
<th>Alarm 3 color</th>
<th>Alarm 4 color</th>
<th>Display characters of each value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Not displayed for AI (mA) channel setting.
2. Appears for channels of high-speed AI modules
3. Not displayed for 4-wire RTD/resistance type.

* When the range type is set to Pulse.
### Pulse input channel settings

<table>
<thead>
<tr>
<th>Range</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chatterring filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference channel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal place</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moving average</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Alarm

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Level 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>Value</td>
<td>Hysteresis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Logging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Output type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Output No.</td>
</tr>
<tr>
<td>Level 2</td>
<td>On/Off</td>
<td>Level 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On/Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Level 4</td>
</tr>
<tr>
<td></td>
<td>On/Off</td>
<td>Alarm delay</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hour</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Minute</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Second</td>
</tr>
</tbody>
</table>

#### Display settings

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lower</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Upper</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scale</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Division</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bar graph</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Base position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Division</td>
</tr>
</tbody>
</table>

### AO channel settings

<table>
<thead>
<tr>
<th>Range</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference channel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preset value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preset value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At power on</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>During stop conditions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Display settings

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lower</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Upper</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scale</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Division</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bar graph</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Base position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Division</td>
</tr>
</tbody>
</table>

### DO channel settings

<table>
<thead>
<tr>
<th>Range</th>
<th>First-CH</th>
<th>Last-CH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Lower</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Span Upper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Energize/De-energize</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay Action on ACK</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay deactivated interval</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Display settings

<table>
<thead>
<tr>
<th>First-CH</th>
<th>Last-CH</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lower</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Upper</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scale</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Division</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bar graph</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Base position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display characters of each value</td>
</tr>
</tbody>
</table>
Setup Menu Map

Display settings

Trend interval
- Trend interval [div]
- Trend rate switching
- Second interval [div]

Group settings
- Group number
- Group settings
  - On/Off
  - Group name
  - Channel set
  - Scale image
  - On/Off
- Trip line 1
  - On/Off
  - Position
  - Color
  - Line width
- Trip line 2
  - On/Off
- Trip line 3
  - On/Off
- Trip line 4
  - On/Off

Message settings
- Message number
- Message
- Message 1

Trend settings
- Direction
- Trend clear
- Trend line
- Grid
- Scale
- Digit
- Value indicator
- Digit of mark
- Partial
- On/Off
- Message
- Write group
- Power-fail message
- Change message

Screen display settings
- Bar graph
- Direction
- LCD
- Brightness
- View angle
- Backlight saver
- Mode
- Saver time
- Restore
- Monitor
- Display background
- Scroll time
- Jump default display
- Calendar display
- 1st weekday
- Changing each value from monitoring
  - On/Off

Measurement settings

Scan interval
- Scan interval
- Value on over-range
- Select unit
- Main unit, Unit 1 to 6

Module 0 - 9
- Operation mode
  - A/D integrate
  - A/D integrate
  - Noise rejection
  - Noise rejection
  - General signal
  - Lower limit of burnout set
  - Upper limit of burnout set
  - Chattering filter for pulse input


1 Does not appear when the measurement mode is Dual interval.
2 Appears when the GX90XA type is -H0 and with PID control modules.
3 Does not appear with high-speed AI or PID control modules.
4 Pulse input module only
5 Does not appear with AO or DO modules.

When the measurement mode is set to dual interval

Dual interval settings

Scan interval
- Measurement group 1
- Measurement group 2
- Master scan interval
- Measurement group number
- Module scan interval
- Main Unit, Unit 1 to 6
- Module 0 to 9
- Measurement group number
- Module 1
- Measurement group number
- Module 9
- Measurement group number

Recording settings

Recording mode
- File type
- Event
data(Measurement group 1)
- Recording interval
- Recording mode
- Data length
- Pre-trigger
- Trigger source operation
- Event
data(Measurement group 2)
- Recording interval
- Recording mode
- Data length
- Pre-trigger
- Trigger source operation

Continued on the next page

1 GX10/GP10 only.
2 Does not appear when the measurement mode is High speed.
3 Does not appear when the measurement mode is Dual interval.
On a GX/GP with the multi-batch function (/BT option) with the function enabled

**Batch settings**

- **Batch function**
  - On/Off
  - Lot-No. digit
  - Auto increment

- **Batch-specific settings**
  - Batch group number
  - Text field number
  - Text field
  - Title of field
  - Characters

**Recording settings**

- **Basic settings**
  - Recording mode
  - File type
  - Directory name
  - File header
  - Characters
  - Data file name
  - Structure
  - Identified strings
  - Media save
  - Auto save
  - Media FIFO
  - File format
  - Display / Event data

- **Recording channel settings**
  - Event data
  - Manual sample

- **Batch function**
  - On/Off
  - Lot-No. digit
  - Auto increment

- **Batch-specific settings**
  - Batch group number
  - Text field number
  - Text field
  - Title of field
  - Characters

**Data save settings**

- **Batch group number**
- **File header**
- **Characters**
- **Data file name**
- **Structure**
- **Identified strings**

**Report settings**

- **Basic settings**
  - Type
  - Creation time
  - Day
  - Day of week
  - Hour
  - Minute
  - Save interval
  - File creation interval
  - Data type
  - Report 1
  - Report 2
  - Report 3
  - Report 4
  - Report 5
  - File type
  - Report template output
    - Excel file
    - PDF file
    - Printer

* Does not appear when the measurement mode is Dual interval.
Setup Menu Map

Electronic signature
PDF electronic signature
Text file
Batch information output

When a PID control module is installed
Control event action
Control event action number
DI/DO/Internal switch registration
Type
Number
Operation/Status output
Content
Detail 1
Number
Detail 2
Number

Report channel settings
Report channel number
Report channel
Channel type
Channel no
Sum scale

Timer settings
Timer
Timer 1
Type
Interval
Day
Hour
Minute
Interval
Action on Math Start
Reset
Reference time
Hour
Minute

Timer 2
Timer 12
Match time timer
Match time timer 1
Type
Timer match condition
Month
Day
Day of week
Hour
Minute
Timer action
Timer action

Match time timer 2
Match time timer 12

Event action
Event action number
Event action
On/Off
Event
Type
Number
Event details
Operation mode
Action
Type
Number
Detail
Group number
Batch group number

Only on GX/GPs with the /AH Aerospace heat treatment
Calibration reminder settings
Schedule number
Reminder function
On/Off
due date
Due date
daily reminder
Re-notification cycle
Notification contents
Title
Notification message 1
Notification message 2
Buzzer
Display settings for date setting
Calibration correction setting

Communication channel settings
On/Off, Span
First-CH
Last-CH
On/Off, Span
On/Off
Decimal place
Span Lower
Span Upper
Unit
At power on
Value at power on
Preset value
Preset value
Watchdog timer
On/Off
Timer
Value at timer-expired

Alarm
First-CH
Last-CH
Level 1
On/Off
Type
Value
Hysteresis
Logging
Output type
Output No.
Level 2
On/Off
Level 3
On/Off
Continued on the next page
### Communication (Ethernet) settings

#### Basic settings

- **Automatic IP settings**
  - Obtain IP address automatically
- **IP Address**
- **Subnet mask**
- **Default gateway**
- **DNS settings**
  - Automatically DNS settings
  - Obtain DNS address automatically
  - DNS settings
  - Primary DNS server
  - Secondary DNS server
  - Domain suffix
  - Primary domain suffix
  - Secondary domain suffix
  - Host settings
- **Host name**
- **Domain name**
- **Host name registration**

#### FTP client settings

- **FTP client function**
  - On/Off
- **Transfer file**
- **Display & Event data**
  - Report
  - Manual sampled data
  - Alarm summary
  - Snap shot
  - Setting file
  - Transfer wait time
  - Display & Event data
  - Report
  - Encryption
  - Verification of certificate
  - FTP connection Primary
  - FTP server name
  - Port number
  - User name
  - Password
  - Directory
  - PASV mode
  - FTP server name
  - Port number
  - User name
  - Password
  - Directory
  - PASV mode

#### SMTP client settings

- **SMTP client function**
  - On/Off
  - Authentication
  - Encryption
  - Verification of certificate
  - SMTP server
  - SMTP server name
  - Port number
  - User name
  - Password
  - POP3 server
  - POP3 server name
  - Port number
  - User name
  - Password

### Calibration correction

- **First-CH**
- **Last-CH**
- **On/Off**
- **Mode**
- **Number of set points**
  - 1
  - Linearizer input
  - Linearizer output
  - 12
  - Linearizer input
  - Linearizer output

Setting when the mode is set to Correction Coefficient on a module with an /AH option

<table>
<thead>
<tr>
<th>Uncorrected value</th>
<th>Instrument correction factor</th>
<th>Sensor correction factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12</td>
<td></td>
</tr>
</tbody>
</table>

### Display settings

- **First-CH**
- **Last-CH**
- **Tag**
- **Characters**
- **No.**
- **Color**
- **Zone**
- **Lower**
- **Upper**
- **Scale**
- **Position**
- **Division**
- **Bar graph**
- **Base position**
- **Division**
- **Partial**
- **On/Off**
- **Expand**
- **Boundary**
- **Color scale band**
- **Band area**
- **Color**
- **Display position Lower**
- **Display position Upper**
- **Alarm point mark**
- **Indicate on Scale**
- **Mark kind**
- **Alarm 1 color**
- **Alarm 2 color**
- **Alarm 3 color**
- **Alarm 4 color**

### Setup Menu Map
E-mail settings
Mail header
Recipient 1
Recipient 2
Sender
Subject
E-mail contents
Header
Include source URL
Alarm settings
Alarm notification
Detection
Channel set
Alarm level 1
Alarm level 4
Attach instantaneous data
Send alarm action
Include tag/ch in Subject
Report settings
Report notification
Scheduled settings
Scheduled notification
Attach instantaneous data
Interval (Recipient 1)
Ref. time hour (Recipient 1)
Ref. time minute (Recipient 1)
Interval (Recipient 2)
Ref. time hour (Recipient 2)
Ref. time minute (Recipient 2)
System settings
Memory full notification
Power failure notification
System error notification
Notification of user lockout

SNTP client settings
SNTP client function
On/Off
SNTP server
SNTP server name
Port number
Query action
Ref. time (Hour)
Ref. time (Minute)
Interval
Timeout
Time adjust on Start action

Modbus client settings
Modbus client function
On/Off
Communication
Interval
Recovery action
Wait time
Connection
Keep connection
Connection timeout

Modbus server settings
Server number
Modbus server settings
Server name
Port number

Command settings
Client commnad number
Command settings
Type
Server
Unit No.
Data type

WT connection client settings
Basic settings
WT connection client function
On/Off
Communication
Interval
Recovery action
Wait time

WT server settings
Server number
WT server settings
On/Off
Server name
Model name

WT data allocation settings
Allocation No
WT data allocation setting
On/Off
Server No
Data group name
Data name
Exponential scaling
Communication channel

SLMP client settings
Basic settings
SLMP client function
On/Off
Data code
Communication
Interval
Connection
Recovery action
Recovery time

SLMP server settings
Server number
SLMP server settings
On/Off
Server name
Model name

Command settings
Client commnad number
Command settings
Type
Server
Request destination network No.
Request destination station No.
Request destination multidrop station No.
Device code
First device number
Data type
Channel type
First-CH
Last-CH

KDC client settings
KDC connection Primary
Server name
Port number
KDC access point Secondary
Server name
Port number

Continued on the next page
### Setup Menu Map

**Certification key**
- Host principal
- Realm name
- Password
- Encryption

**Server settings**
- Keep alive function
- Timeout function
- FTP server
- Output Directory Format
- Modbus server
- Modbus delay response

**Server function**
- Allowed Modbus clients
  - Modbus client connect limits function
  - 1
  - 10
- FTP server
  - On/Off
  - IP Address
- Server list
  - FTP
  - On/Off
  - Encryption
  - Port number
  - HTTP
  - On/Off
  - Encryption
  - Port number
  - SNTP
  - On/Off
  - Port number
  - MODBUS
  - On/Off
  - Port number
  - GENE
  - On/Off
  - Port number
  - EtherNet/IP
  - On/Off
  - DARWIN
  - On/Off
  - Channel conversion
  - OPC-UA
  - On/Off
  - Port number

**Communication(Serial) settings**
- Basic settings
  - Receiver
  - Function
  - Address
  - Data transfer
  - Baud rate
  - Parity bit
  - Stop bit
  - Data length
  - Handshake
  - Logout
  - Auto logout
  - DARWIN
  - Channel conversion

**Modbus master**
- Basic setting
  - Master function
  - Communication
  - Interval
  - Communication timeout
  - Gap between messages
  - Recovery action
  - Retransmission
  - Wait time

**Command settings**
- Master command number
  - Command settings
  - Type
  - Slave
  - Data type
  - Register
  - Channel type
  - First-CH
  - Last-CH

**Web content selection**
- User level: User
  - DO channel status/COMM status, etc.
  - Log
  - System information/Network information
  - File
- User level: Monitor
  - DO channel status/COMM status, etc.
  - Log
  - System information/Network information
  - File

1. On a GX/GP with the advanced security function (/AS option) with the function enabled
2. Only on GX/GPs with the /E2 WT communication option.
3. Only on GX/GPs with the /E1 EtherNet/IP communication option.
4. Only on GX/GPs with the /E4 SLMP communication option.
5. Only on GX/GPs with the /E3 OPC-UA server.
### Setup Menu Map

#### System settings

<table>
<thead>
<tr>
<th>Environment settings</th>
<th>Language</th>
<th>Temperature</th>
<th>Decimal Point Type</th>
<th>Date format</th>
<th>Date format</th>
<th>Delimiter</th>
<th>Month indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm basic settings</td>
<td>Rate of change</td>
<td>Decrease</td>
<td>Increase</td>
<td>Indicator</td>
<td>Hold/Nonhold</td>
<td>Alarm ACK</td>
<td>Individual alarm ACK</td>
</tr>
<tr>
<td>Time basic settings</td>
<td>Time zone</td>
<td>Hour</td>
<td>Minute</td>
<td>Gradually adjusting the time</td>
<td>Time deviation limit</td>
<td>Time adjustment beyond limit</td>
<td>Daylight Saving Time</td>
</tr>
<tr>
<td>Internal switch settings</td>
<td>First number</td>
<td>Last number</td>
<td>Internal switch</td>
<td>Type</td>
<td>And/Or</td>
<td>Preset action</td>
<td>At power on</td>
</tr>
<tr>
<td>Status relay</td>
<td>Fail relay</td>
<td>Memory/Media status</td>
<td>Measurement error</td>
<td>Communication error</td>
<td>Record stop</td>
<td>Alarm</td>
<td></td>
</tr>
<tr>
<td>Printer settings</td>
<td>IP Address</td>
<td>Paper size</td>
<td>Page orientation</td>
<td>Resolution (dpi)</td>
<td>Number of copies</td>
<td>Snapshot</td>
<td>Paper size indicator</td>
</tr>
<tr>
<td>Sound, LED</td>
<td>Sound</td>
<td>Touch</td>
<td>Warning</td>
<td>LED</td>
<td>MENU key LED</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Security settings

<table>
<thead>
<tr>
<th>Basic settings</th>
<th>Security function</th>
<th>Touch operation</th>
<th>Communication</th>
<th>Logout</th>
<th>Auto logout</th>
<th>Operation without Login</th>
<th>Password management</th>
<th>On/Off</th>
<th>Root user password</th>
<th>Password retry</th>
<th>User ID</th>
<th>On/Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>User settings</td>
<td>User number</td>
<td>User settings</td>
<td>User level</td>
<td>Mode</td>
<td>User name</td>
<td>User ID</td>
<td>Initialize password</td>
<td>Password expiration</td>
<td>User property</td>
<td>Authority number</td>
<td>Sign in property</td>
<td>Authority of signature</td>
</tr>
<tr>
<td>Authority of user</td>
<td>Authority number</td>
<td>Authority of user</td>
<td>Record</td>
<td>Math</td>
<td>Data save</td>
<td>Message</td>
<td>Batch</td>
<td>Alarm ACK</td>
<td>Communication</td>
<td>Touch operation</td>
<td>Time set</td>
<td>Setting operation</td>
</tr>
</tbody>
</table>

1. On a GX/GP with the advanced security function (/AS option) with the function enabled.
1 On a GX/GP with the advanced security function (IAS option) with the function enabled.
2 When a PID control module is installed.
3 When a PID control module and program control (PG option) is installed.
### Calibration correction

<table>
<thead>
<tr>
<th>Unit Number</th>
<th>Slot Number</th>
<th>Mode</th>
<th>Mode</th>
<th>Number of set points</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linearizer input</td>
<td>Linearizer output</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting when the mode is set to Correction Coefficient on a module with an /AH option

<table>
<thead>
<tr>
<th>Uncorrected value</th>
<th>Instrument correction factor</th>
<th>Sensor correction factor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Execution of the input measurement</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Output settings

<table>
<thead>
<tr>
<th>Re-Trans</th>
<th>Unit Number</th>
<th>Slot Number</th>
<th>AO number</th>
<th>Re-Trans</th>
<th>On/Off</th>
<th>Type</th>
<th>Minimum value of input scale</th>
<th>Maximum value of input scale</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Split computation

<table>
<thead>
<tr>
<th>Unit Number</th>
<th>Slot Number</th>
<th>AO number</th>
<th>Mode</th>
<th>On/Off</th>
<th>Output 0% segmental point</th>
<th>Output 100% segmental point</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Output type

<table>
<thead>
<tr>
<th>Unit Number</th>
<th>Slot Number</th>
<th>AO number</th>
<th>Output type</th>
<th>Type</th>
<th>Cycle time</th>
<th>Current output range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Input settings

<table>
<thead>
<tr>
<th>Measurement input range</th>
<th>Unit Number</th>
<th>Slot Number</th>
<th>AI number</th>
<th>Range</th>
<th>Type</th>
<th>Calculation</th>
<th>Scale</th>
<th>Decimal place</th>
<th>Scale Lower</th>
<th>Scale Upper</th>
<th>Unit</th>
<th>Low-cut</th>
<th>On/Off</th>
<th>Low-cut value</th>
<th>Low-cut output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Input/Output settings

<table>
<thead>
<tr>
<th>DO settings</th>
<th>Unit Number</th>
<th>Slot Number</th>
<th>DO number</th>
<th>Range</th>
<th>Type</th>
<th>DO function selection</th>
<th>Type</th>
<th>Action</th>
<th>Energize/De-energize</th>
<th>Action</th>
<th>Hold</th>
<th>Relay Action on ACK</th>
<th>Relay deactivates interval</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### DO settings

<table>
<thead>
<tr>
<th>DO settings</th>
<th>Unit Number</th>
<th>Slot Number</th>
<th>DO number</th>
<th>Range</th>
<th>Type</th>
<th>DO function selection</th>
<th>Type</th>
<th>Action</th>
<th>Energize/De-energize</th>
<th>Action</th>
<th>Hold</th>
<th>Relay Action on ACK</th>
<th>Relay deactivates interval</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Setup Menu Map
### PV/RSP settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control PV input range</td>
<td></td>
</tr>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Decimal point</td>
<td></td>
</tr>
<tr>
<td>Minimum value of input range</td>
<td></td>
</tr>
<tr>
<td>Maximum value of input range</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
</tr>
<tr>
<td>Input switching PV range</td>
<td></td>
</tr>
<tr>
<td>Input switching PV low limit</td>
<td></td>
</tr>
<tr>
<td>Input switching PV high limit</td>
<td></td>
</tr>
</tbody>
</table>

### EXPV function

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>EXPV</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Channel number</td>
<td></td>
</tr>
<tr>
<td>EXPV2</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Channel number</td>
<td></td>
</tr>
</tbody>
</table>

### RSP function

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>RSP</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Channel number</td>
<td></td>
</tr>
<tr>
<td>AI terminal number</td>
<td></td>
</tr>
<tr>
<td>Remote input</td>
<td></td>
</tr>
<tr>
<td>Input filter</td>
<td></td>
</tr>
<tr>
<td>Input ratio</td>
<td></td>
</tr>
<tr>
<td>Input bias</td>
<td></td>
</tr>
<tr>
<td>Bias</td>
<td></td>
</tr>
</tbody>
</table>

### Output settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Preset output</td>
<td></td>
</tr>
<tr>
<td>Input error preset output</td>
<td></td>
</tr>
<tr>
<td>Output limiter switch</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
</tbody>
</table>

### Operation parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Stand-by action</td>
<td></td>
</tr>
<tr>
<td>Hysteresis</td>
<td></td>
</tr>
<tr>
<td>On-delay timer (minutes)</td>
<td></td>
</tr>
<tr>
<td>On-delay timer (seconds)</td>
<td></td>
</tr>
<tr>
<td>Off-delay timer (minutes)</td>
<td></td>
</tr>
<tr>
<td>Off-delay timer (seconds)</td>
<td></td>
</tr>
<tr>
<td>Relay action/behavior</td>
<td></td>
</tr>
<tr>
<td>PV velocity alarm time setpoint (minutes)</td>
<td></td>
</tr>
<tr>
<td>PV velocity alarm time setpoint (seconds)</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>Level 4</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>SP number</td>
<td></td>
</tr>
<tr>
<td>Alarm level 1 setpoint</td>
<td></td>
</tr>
<tr>
<td>Alarm level 4 setpoint</td>
<td></td>
</tr>
</tbody>
</table>

### Control alarm

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Stand-by action</td>
<td></td>
</tr>
<tr>
<td>Hysteresis</td>
<td></td>
</tr>
<tr>
<td>On-delay timer (minutes)</td>
<td></td>
</tr>
<tr>
<td>On-delay timer (seconds)</td>
<td></td>
</tr>
<tr>
<td>Off-delay timer (minutes)</td>
<td></td>
</tr>
<tr>
<td>Off-delay timer (seconds)</td>
<td></td>
</tr>
<tr>
<td>Relay action/behavior</td>
<td></td>
</tr>
<tr>
<td>PV velocity alarm time setpoint (minutes)</td>
<td></td>
</tr>
<tr>
<td>PV velocity alarm time setpoint (seconds)</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>Level 4</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>SP number</td>
<td></td>
</tr>
<tr>
<td>Alarm level 1 setpoint</td>
<td></td>
</tr>
<tr>
<td>Alarm level 4 setpoint</td>
<td></td>
</tr>
</tbody>
</table>

### Target setpoint

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>SP ramp-rate settings</td>
<td></td>
</tr>
<tr>
<td>Ramp-down rate</td>
<td></td>
</tr>
<tr>
<td>Ramp-rate</td>
<td></td>
</tr>
<tr>
<td>Ramp-rate</td>
<td></td>
</tr>
<tr>
<td>Ramp-rate</td>
<td></td>
</tr>
<tr>
<td>SP number 1</td>
<td></td>
</tr>
<tr>
<td>Target setpoint</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>SP number 8</td>
<td></td>
</tr>
<tr>
<td>Target setpoint</td>
<td></td>
</tr>
</tbody>
</table>

### PID number/Reference point

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>SP number 1</td>
<td></td>
</tr>
<tr>
<td>PID number</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>SP number 8</td>
<td></td>
</tr>
<tr>
<td>PID number</td>
<td></td>
</tr>
<tr>
<td>Reference point</td>
<td></td>
</tr>
<tr>
<td>Point 1</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>Point 8</td>
<td></td>
</tr>
<tr>
<td>Zone PID switching</td>
<td></td>
</tr>
<tr>
<td>hysteresis</td>
<td></td>
</tr>
<tr>
<td>Reference deviation</td>
<td></td>
</tr>
<tr>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Reference deviation</td>
<td></td>
</tr>
</tbody>
</table>

### PID settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>PID number</td>
<td></td>
</tr>
<tr>
<td>Proportional band</td>
<td></td>
</tr>
<tr>
<td>Integral time</td>
<td></td>
</tr>
<tr>
<td>Derivative time</td>
<td></td>
</tr>
<tr>
<td>Control output low limit</td>
<td></td>
</tr>
<tr>
<td>Control output high limit</td>
<td></td>
</tr>
<tr>
<td>Tight shut function</td>
<td></td>
</tr>
<tr>
<td>Manual reset</td>
<td></td>
</tr>
<tr>
<td>Upper-side hysteresis</td>
<td></td>
</tr>
<tr>
<td>Lower-side hysteresis</td>
<td></td>
</tr>
<tr>
<td>Direct/Reverse action</td>
<td></td>
</tr>
<tr>
<td>switch</td>
<td></td>
</tr>
<tr>
<td>Preset output</td>
<td></td>
</tr>
</tbody>
</table>

### PID settings (Reference PID)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Proportional band</td>
<td></td>
</tr>
<tr>
<td>Integral time</td>
<td></td>
</tr>
<tr>
<td>Derivative time</td>
<td></td>
</tr>
<tr>
<td>Control output low limit</td>
<td></td>
</tr>
<tr>
<td>Control output high limit</td>
<td></td>
</tr>
<tr>
<td>Tight shut function</td>
<td></td>
</tr>
<tr>
<td>Manual reset</td>
<td></td>
</tr>
<tr>
<td>Upper-side hysteresis</td>
<td></td>
</tr>
<tr>
<td>Lower-side hysteresis</td>
<td></td>
</tr>
<tr>
<td>Direct/Reverse action</td>
<td></td>
</tr>
<tr>
<td>switch</td>
<td></td>
</tr>
<tr>
<td>Preset output</td>
<td></td>
</tr>
</tbody>
</table>

### Control detail settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop number</td>
<td></td>
</tr>
<tr>
<td>Tracking</td>
<td></td>
</tr>
<tr>
<td>SP tracking</td>
<td></td>
</tr>
<tr>
<td>PV tracking</td>
<td></td>
</tr>
<tr>
<td>SP limit</td>
<td></td>
</tr>
<tr>
<td>Low limit</td>
<td></td>
</tr>
<tr>
<td>High limit</td>
<td></td>
</tr>
<tr>
<td>SP ramp-rate time unit</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
</tr>
</tbody>
</table>

Continued on the next page
Setup Menu Map

Control display

Control group settings
- Group number
- Group settings
- Group On/Off
- Group name
- Division

Output velocity limiter
- On/Off
- Value
- Auto-tuning
- Type
- Output low limit
- Output high limit
- SP bias
- Anti-reset windup
- Type
- Value
- Overshoot suppressing function
- Super function

Loop display settings
- Loop number
- Tag
- Characters
- No.
- Color
- Pattern Color
- Deviation display band
- Deviation display band

PID channel settings
- Channel no
- Tag
- Characters
- No.
- Color
- Zone
- Lower
- Upper
- Scale
- Position
- Division
- Bar graph
- Base position
- Division
- Partial
- On/Off
- Expand
- Boundary

Screen display settings
- Display background
- Manual output operation type

Program pattern settings

Program Run/Reset message
- Automatic switch to program operation display
- Program RUN detail settings

Editing Program Pattern

Program pattern EDIT menu

Initial settings

Pattern initial settings
- Pattern name
- Number of loops used
- Action loop
- Loop 1
- Loop 20

Program starting conditions
- Starting target setpoint
- Loop 1
- Loop 20
- Start code
- Reference loop number

Wait function settings
- Zone number
- Loop 1
- Wait function
- Lower-side wait zone
- Upper-side wait zone
- Loop 20
- Wait function
- Lower-side wait zone
- Upper-side wait zone